
 
 
 
 
 
 
 

 
 
 

EXTENDED PROCESS SIMULATION  
SYSTEM 

 
 

Windows Interface for XPSIM v.3.02 
 
 
 

User Manual 
 
 
 
 

Rev. 12.0 
 

July 2024 
 
 
 
 
 

 
 
 
 
 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 2 

Document History 
 

Rev. Date Issue 
0.0 March 31, ,2006 Draft 
0.1 July 31, ,2006 Issued 
0.2 October 20, ,2006 Issued 
0.3 February 13, ,2007 Issued for version 1.03 
0.4 June 21, ,2007 Issued for version 1.05 
1.0 January 10, 2008 Issued for version 1.06 
2.0 January 7, 2009 Issued for version 1.07 
3.0 January 11, 2010 Issued for XPSIM version 1.08 
4.0 April 1, 2011 Issued for XPSIM version 1.09 
5.0 July 31, 2012 Issued for XPSIM version 2.00 
6.0 October 17, 2013 Issued for XPSIM version 2.01 
7.0 July 31, 2015 Issued for XPSIM version 2.02 
8.0 January 11, 2017 Issued for XPSIM version 2.03 
9.0 June 25, 2018 Issued for XPSIM version 3.00 

10.0 May 2, 2021 Issued for XPSIM version 3.00 – mod. 06 
11.0 July 13, 2022 Issued for XPSIM version 3.01 
12.0 July 15, 2024 Issued for XPSIM version 3.02 

 
 
XPSIM documentation 
The set of XPSIM v. 3.02 documentation is listed in the table below. 
 

No Title Rev. Issue 
1 Windows Interface for XPSIM v.3.02 (***) 12 Jul, 2024 

2 User Manual - Keyword Input - Language Reference 10.0 Jun, 2022 

5 Dynamic Simulation Options for XPSIM v.3.02 - Reference Manual 6 Jul, 2024  

3 Installation Manual 14 Jul, 2024 

 
 (***)  this document. 

 
 

Abbreviation and acronyms 
 
UoM  Units of Measure 
UOP  Unit operation (e.g., valve, compressor, column, etc.) 
Pfd  Process Flow Diagram 
 
  



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 3 

 
 
 

TABLE OF CONTENTS 
 
0. Copyright and General Disclaimer .............................................................................. 6 
1. General Information..................................................................................................... 8 

1.1 XPSIM installation ............................................................................................... 8 
2. User Interface .............................................................................................................. 9 

2.1 How to start XPSIM ............................................................................................. 9 
2.2 Application Desktop ............................................................................................. 9 
2.3 Manipulating the main and child windows ......................................................... 10 
2.4 Basic Commands and Functions ........................................................................ 11 
2.5 File menu ............................................................................................................ 12 
2.6 Options menu ..................................................................................................... 12 
2.7 View menu ......................................................................................................... 12 
2.8 Tools menu ......................................................................................................... 13 
2.9 Main Interface Modes......................................................................................... 13 
2.10 How to close XPSIM ...................................................................................... 13 

3. Process Flow-Sheet  creation ..................................................................................... 14 
3.1 Starting a new PFD ............................................................................................. 14 
3.2 File and other menus .......................................................................................... 15 
3.3 Pfd Toolbar ......................................................................................................... 15 
3.4 File Menu ........................................................................................................... 15 
3.5 Placing Unit Operations ..................................................................................... 16 
3.6 Deleting Unit Operations .................................................................................... 17 
3.7 Placing a Stream ................................................................................................. 18 
3.8 Connecting Streams to Unit Operations ............................................................. 18 
3.9 Deleting a Stream ............................................................................................... 19 
3.10 Operations on streams ..................................................................................... 20 
3.11 Changing stream connections and path........................................................... 21 
3.12 Actions on Unit Operations ............................................................................ 22 
3.13 Pfd settings ...................................................................................................... 23 
3.14 Zoom specification ......................................................................................... 26 
3.15 Pfd scrolling .................................................................................................... 26 
3.16 Symbol manipulation ...................................................................................... 27 
3.17 Moving Unit Operations ................................................................................. 28 
3.18 Changing the size of Unit Operations symbols ............................................... 29 
3.19 Moving groups of units ................................................................................... 31 
3.20 Deleting a group of units ................................................................................ 32 
3.21 Changing scale factors of a group of units ...................................................... 32 
3.22 Shifting Unit Operations and Streams ............................................................ 33 
3.23 Renaming Unit Operations ............................................................................. 33 
3.24 Renaming Streams .......................................................................................... 34 
3.25 Finding an object ............................................................................................ 35 
3.26 View commands/options ................................................................................. 35 

4. Simulation Data ......................................................................................................... 37 
4.1 Inserting new categories ..................................................................................... 40 
4.2 Inserting statements ............................................................................................ 41 
4.3 Statement Data windows .................................................................................... 44 
4.4 Standard Format ................................................................................................. 45 
4.5 Table Format ...................................................................................................... 48 
4.6 Help function ...................................................................................................... 53 
4.7 Component selection .......................................................................................... 54 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 4 

4.8 Selection of elements from lists ......................................................................... 55 
4.9 Inserting Stream or Unit Operation names ......................................................... 56 
4.10 Moving statements .......................................................................................... 57 
4.11 Copy and paste statements .............................................................................. 57 
4.12 Selecting objects ............................................................................................. 58 
4.13 Navigating statements ..................................................................................... 59 
4.14 Statements with input errors ........................................................................... 60 
4.15 Disabling statements ....................................................................................... 60 
4.16 Notes & Remarks Window ............................................................................. 61 

5. Simulation Creation ................................................................................................... 62 
5.1 RUN statement ................................................................................................... 62 
5.2 DESC statement ................................................................................................. 62 
5.3 DIMENSION statement ..................................................................................... 63 
5.4 System Data category ......................................................................................... 63 
5.5 Chemical Components list .................................................................................. 63 
5.6 Chemical Components from Library .................................................................. 64 
5.7 Thermodynamic and transport properties ........................................................... 66 
5.8 Drawing a Flowsheet .......................................................................................... 67 
5.9 Some remarks about distillation columns ........................................................... 68 
5.10 Some remarks about recycle problems ........................................................... 69 
5.11 Saving the current problem ............................................................................. 69 

6. Units of Measure – Definition and Conversion ......................................................... 70 
6.1 Standard format .................................................................................................. 71 
6.2 Table format ....................................................................................................... 73 
6.3 Guidelines for UoM Conversion ........................................................................ 74 

7. Keyword Input Files .................................................................................................. 75 
7.1 File Menu ........................................................................................................... 76 
7.2 Edit menu ........................................................................................................... 76 
7.3 View menu ......................................................................................................... 76 
7.4 Window  menu ................................................................................................... 78 

8. Executing a Simulation Run ...................................................................................... 79 
8.1 General Information ........................................................................................... 79 
8.2 EXEC  menu ....................................................................................................... 79 
8.3 Keyword Input file ............................................................................................. 80 
8.4 Running the simulation....................................................................................... 80 
8.5 Fixing Input Errors ............................................................................................. 82 
8.6 Set system options .............................................................................................. 84 

9. Viewing and Analysing Results ................................................................................. 86 
9.1 Basic Stream Data .............................................................................................. 86 
9.2 Browsing Streams and Unit Operations ............................................................. 87 
9.3 Heat and Material Balance view ......................................................................... 89 
9.4 Opening results files ........................................................................................... 90 
9.5 Global Output Window ...................................................................................... 90 
9.6 Output Windows ................................................................................................. 92 
9.7 Save output file ................................................................................................... 92 
9.8 Print and Print Preview ....................................................................................... 93 

10. Graph documents ................................................................................................... 95 
10.1 General information ........................................................................................ 95 
10.2 Available Operations ...................................................................................... 98 
10.3 Customization Options ................................................................................... 99 
10.4 Tools for graphs management ....................................................................... 103 

11. Property Tables for OLGA and LedaFlow ........................................................... 105 
11.1 3D Property Surfaces .................................................................................... 107 

12. Importing Keyword Files ..................................................................................... 109 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 5 

13. How to prepare and run a simple simulation........................................................ 111 
14. Advanced options and functions .......................................................................... 117 

14.1 Export object ................................................................................................. 117 
14.2 Import object ................................................................................................. 117 
14.3 Create stream data from results..................................................................... 118 
14.4 Export data to Excel ...................................................................................... 119 
14.5 Extract keyword input ................................................................................... 119 
14.6 Merge Input File ........................................................................................... 120 

15. Dynamic Simulation ............................................................................................ 121 
15.1 Dynamic Option ............................................................................................ 121 
15.2 Plant View Interface ..................................................................................... 122 
15.3 Command buttons ......................................................................................... 124 
15.4 Plant View Menu Commands ....................................................................... 127 
15.5 Update Refresh Frequency ............................................................................ 128 
15.6 Plotting trend and history graphs .................................................................. 128 

16. Managing P&I Pages ........................................................................................... 129 
16.1 Open and view a collection ........................................................................... 129 
16.2 Commands .................................................................................................... 130 
16.3 Instruments and Control values .................................................................... 131 
16.4 Instrument Value Format .............................................................................. 132 

 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 6 

0. Copyright and General Disclaimer 

This manual is intended as a guide for using the XPSIM software. This documentation 
contains proprietary and confidential information and may not be disclosed, used or copied 
without the prior consent of the owner as set forth in the applicable license agreement. 
Users are solely responsible for the proper use of the software and the application of the 
results obtained. 
 
This manual includes technical documentation. This documentation is delivered to the user 
as is, it may include technical or typographical inaccuracies and errors. The author makes 
no warranty as to its accuracy or use. Any use of this technical documentation or the 
information contained in this manual is at the risk of the user. 
 
The owner does not make any representations regarding the use, or the results of use of the 
software, in terms of correctness or otherwise. The entire risk as to the results and 
performance of the software is assumed by the user. 
 
The owner reserves the right to make changes to this manual and the related computer 
software applications and components without obligation to notify any person or 
organization. 
 
Companies, names and calendar dates used in the examples contained in this manual are 
fictitious unless otherwise indicated. 
 
The author makes no warranty or representation, either expressed or implied, with respect 
to this documentation, its quality, performance, merchantability or fitness for a particular 
purpose. 
 
 
Trademarks 
• Windows 11, Windows 10, Windows 7, MS-DOS and Microsoft Office Excel are 

trademarks of Microsoft Corporation. 
• OLGA is a trademark of Schlumberger. 
• LedaFlow is a trademark of Kongsberg Oil & Gas Technologies 
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1. General Information 

This document provides basic information on the XPSIM Windows Interface application 
which drives the use of: 

• XPSIM  steady state simulation program 
• XDSIM  dynamic simulation program 

in the Windows environment. 
 
It describes the capabilities of the XPSIM windows interface and includes general 
instructions for using its features. It is directed primarily toward users already familiar with 
the Microsoft Windows interface, so detailed instructions for using the mouse, menus and 
other windows objects are not given. 
 
This software application allows executing XPSIM simulation program in a MS Windows 
environment. 
 
The user can: 
• create new simulations and process flow diagrams (PFD)  
• open and edit XPSIM/XDSIM input files 
• inserting new streams and unit operations 
• modify existing unit operations and change the PFD layout 
• run the simulation  
• view and print result data and files 
• view and print results shown as graphs 
• export stream data to MS Excel 
 
In the following chapters, the main functions available are explained in detail. 
 
Remark 
Screen images and outputs, contained in this manual, can show version numbers lower 
than the current one (v. 3.02) and can be slightly different in their layout but are still valid 
in their structure. 

1.1 XPSIM installation 
The installation of XPSIM and its related documentation is described by the manual: 

XPSIM - EXTENDED PROCESS SIMULATION SYSTEM  
Installation Manual - Version 3.02- 
Rev. xx – month, day year 
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2. User Interface 

The XPSIM Windows Interface implements a multi-document interface (MDI) 
architecture that allows the user to work on multiple documents and views at the same time, 
with each document shown in its own window. 
At a time, the number of open windows can be very large; for example if a simulation 
generates 20 graphs the user can, in principle, open each graph in a separate window and 
have 20 graph windows open. 
 
The terms 'file', 'document' and 'window' may be considered synonyms because each 
document is usually contained/saved in a file and each document is shown in its own 
window. 
 
The documents that may be viewed and/or edited are: 
• input files 
• process flow diagram (PFD) schemas 
• output files 
• graphs 
 
This chapter describes how to start and exit XPSIM and describes some basic Windows 
features as they appear and are used in the XPSIM windows interface. 

2.1 How to start XPSIM 
To start the application the user can: 
• double-click on the XPSIM icon on the desk-top 
• launch the XPSIM application from the Start/Program Folder 
 
The XPSIM welcome window will appear, as shown on Fig. 2.1. 

2.2 Application Desktop 
As usual, with applications that display multiple windows only one window is active at a 
time. The user may activate one window by simply clicking on it or selecting the desired 
window from the 'Window' menu. 
 
When the application is started, usually from the program folder or a program icon, the 
main window is presented (see next Fig. 2.1). 
 
On the main window, the user may easily identify the following parts: 
 
Title bar the title bar is the horizontal bar at the top of the window; it 

displays the application name and the run identifier. 
 
Menu bar the menu bar is the horizontal bar below the title bar. It contains 

the names of the available menus. 
 
Tool bar  the tool bar is the horizontal bar below the menu bar. It contains 

buttons that when clicked execute command (also available from 
the menu bar). 
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Status bar the status bar is the horizontal bar at the bottom of the main 
window. It displays help messages for menu items, and other 
information. 

 
The menu bar is automatically updated to reflect the commands available, allowing the user 
to work on the active document (window). 
Some drop-down menu operations are possible only after other operations have been 
performed. Following the Windows convention, when the status of the application does not 
permit the execution of a command, its name will appear grayed on the drop-down menu. 
 
The user may begin edit this input files inserting the input statements or may open another 
input file. 

2.3 Manipulating the main and child windows 
 
Windows present on the top right corner the standard icons: 
 

 Maximize icon  when pressed the window is enlarged to fill all the 
available client area of the main window. 
 

 Minimize icon when pressed the window is compressed to the dimension of a bar 
containing the window title and the standard buttons. 
 

 Restore icon when pressed the window is resized to the dimensions it had 
previous of the last window size operation applied.  
 

 Close icon  when pressed closes the window and the related document. 
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Figure 2.1 - XPSIM main window with welcome dialog 
 

 

2.4 Basic Commands and Functions 
The base menu is active when there are no open documents (input files). It presents the 
following commands: 
 
File 
• New 
• Open … 
• Close 
• Print Setup … 
• … list of recently-used files …. 
• Exit 
 
Dynamic 
• Set Dynamic Simulation option 
• P&I pages … 
 
Tools 
• Open graph file … 
• Graph collection ► 
• View graph results … 
• Property Tables … 
 
View 
• Tool Bar 
• Status Bar 
• Application look ► 
• Large Uop palette buttons 
 
Help 

Tool Bar 
Menu Bar 

Title Bar 

Status Bar 
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• Help topics 
• About XpsimWin 
 
All these commands are described in detail in the following paragraphs. 

2.5 File menu 
New opens a new empty simulation problem. 
 
Open … opens an already existing simulation input. The standard 'File 

open' dialog is displayed to allow the user to select the desired 
input file. 

 
Print setup invokes the standard 'Print Setup' dialog. The user will so select 

the desired printer and the page layout. Vertical (portrait) or 
horizontal (landscape) page positions may be selected. 

 
recently used files the latest used files are listed under the 'File' drop down menu. 

By selecting one file-name, the file is automatically opened and 
displayed in a new window. 

 
Exit closes the main window and terminates the application. When 

selected, the user is requested to confirm this choice before all 
open documents are closed and the application terminated. 

2.6 Options menu 
The following general commands are available. 
 
Dynamic simulation activates / deactivates the Dynamic Simulation Option. 
 
P&I pages ► allows to create a new collection or to open an existing collection 

of P&I (Process and Instrument diagram) pages. Created P&I 
pages can be used in a dynamic simulation. 

2.7 View menu 
The following general commands are available. 
 
Tool Bar hides or shows the tool bar. 
 
Status Bar hides or shows the status bar 
 
Application Look set the look of the main window to the selected style 
 
Large Uop palette buttons set toolbar and uop palette buttons to a lerger size 
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2.8 Tools menu 
This menu allows to open graph collections and graph files generated by previous 
simulation. It is also possible to generate and/or edit P&I pages. 
 
Open graph file … opens a graph file (.gph extension) generated in a previous 

Xpsim session. 
 
Graph collection this command opens graph collections (files with .bgr extension) 

allowing the user to view and or edit contained graphs. 
 
View graph results … this command becomes available after a graph collection (.bgr 

file) is linked.  
 
Property tables … allows to open and browse property table files (to be used by the 

OLGA or LedaFlow software) generated by Xpsim o by another 
application. 

2.9 Main Interface Modes 
For the definition of a simulation problem, the user may select one amongst three main 
modes of operation. 
 

1. Supply data using two logically connected windows: 
• 'Process Flow Diagram' window, and 
• 'Simulation Data' window  

 
2. Supply input data as a ASCII text file using keywords, based directly on the 

XPSIM simulation input language, based on a keyword format. 
 
In the Process Flow Diagram the user can create streams and unit operations, connect them 
and build the topology of the plant, he wants to simulate. 
 
In the 'Simulation Data’ window the user specifies all the parameters of streams, unit 
operations, and other objects that are required to effectively run the simulation. 

2.10 How to close XPSIM 
To close the application the user should: 
 
• Close all the windows related to the open problem. 
• Close the main XPSIM window or select the ‘Exit’ command from the File menu. 
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3. Process Flow-Sheet  creation 

This section describes how the user can create a diagram of the process to be simulated. 
This diagram is usually called ‘Process Flow Sheet’ or ‘Process Flow Diagram’ (PFD). 

3.1 Starting a new PFD 
When a new simulation is started, the following dialog is prompted: 

 
Fig. 3.1 – Simulation type dialog 

 

 
 
By selecting the 'simulation linked’ mode two main windows are opened: 
• process flow-sheet  and data window 
• simulation running window 
 
Both windows are divided into parts which display separated data. They are presented with 
tabs, to activate each window the user can click on its tab. 
They are positioned so as to occupy the upper and lower part of the main window (see next 
Fig. 3.2). 
 
The two main windows, when opened, will appear as typically shown on next Fig 3.2 
 

Fig.3.2 -   Pfd and Simulation Data Windows 
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The “process flow-sheet  and data window” (PFD window) is the main problem window, 
a problem is closed by closing this window. 
The “simulation running window” is automatically created when the main window is 
created and destroyed when the main window is closed. 
 
The user can change the dimension of the divided part by clicking on the separation borders 
and dragging them to the desired position. 

3.2 File and other menus 
The menu items, available when a PFD window is active, contain the following commands: 
 
File 
• Print, Print Preview, Print Setup... 
• Exit 
 
View 
• Set zoom value, Set mesh 
• Toolbar, Status Bar 
 
Window 
• Cascade 
• Tile 
• Arrange Icons 
 
In this window the user can: 
• create and place streams 
• create and place unit operations 
• connect stream and unit operations 
• delete streams and unit operations 
 
According to these operations simulation data are automatically created (or deleted) and 
input statements are prepared to be completed by the user. 

3.3 Pfd Toolbar 
Logically connected to the Pfd window, the “Pfd symbols” palette is created and 
positioned, by defaults, on the right of the application window, as shown on Fig: 3.2. 
 
The user can move its position using the ‘Pfd toolbar’ command available under the ‘View’ 
menu’. Using this command, the toolbar may be placed on one of the four sides (right, left, 
top or bottom) of the Pfd window. 

3.4 File Menu 
 
Print  this command invokes the standard 'Print' dialog for starting the 

printing process on the selected device. The PFD drawing is 
always printed in a single page and it  is so scaled to fit the page 
size. 
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Print setup  this command invokes the standard 'Print setup' for selecting the 
printer and the page layout. For printing PFD drawings the 
horizontal page layout is to be preferred. 

3.5 Placing Unit Operations 
On the right side of the main window, a “Pfd palette” is arranged; this is a vertical shaped 
window containing small icons for streams and unit operations. 
 
The 'Pfd palette' is available only when the user's focus is on the Pfd window. 
 
To place a unit operation in the Pfd window : 
• click on the “pfd palette” the icon of the unit to be placed 
• move the mouse cursor at the point of the Pfd where the unit is to be placed and left-

click. 
 
When these actions are completed, the symbol of the selected Unit Operation appears on 
the PFD window. 
 
Repeat these actions to place other unit operations. 
 
If the selected unit operation requires additional parameters to be fully specified, a dialog 
box is prompted to the user before the unit operation symbol is created. 
 
For example, when a FLASH unit operation is placed on the Pfd the following dialog is 
presented to the user. 
The dialog requires the specification of the number and type of product streams. 
 

Fig. 3.3  -  FLASH unit specification dialog 
 

 
 
The symbol of the unit operation is created with small size to minimize possible overlaps 
with the symbols of other units. The user can then change its initial size using the symbol 
resizing handles or the ‘Scale symbol’ function. 
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Fig. 3.4  -  PFD Window after creation of a Flash Unit 
 

 
 
When a unit operation is placed on the “Pfd window”, the corresponding object is 
automatically created in the Simulation Data tree view. 
 
So, as shown on Fig. 4, a FLASH symbol has been placed on the Pfd window, and the 
corresponding FLASH object appears in the Simulation Data tree view. 

3.6 Deleting Unit Operations 
To delete a unit operation placed on the Pfd, you should do the following actions : 
 
• left-click on the unit operation symbol to identify it (a rectangle, drawn with a dot line, 

will appear around the selected symbol). 
• press the 'Canc' button on the keyword. 
 
A warning message box appears to ask for confirmation of the delete request. 
• select OK to complete the operation  
• select Cancel to ignore the delete request. 
 
Deleting a unit operation can also be performed by selecting the Delete command in the 
Edit menu. 
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3.7 Placing a Stream 
The first icon in the 'Pfd palette' is associated to process streams. 
 
To create a stream in the Pfd window, the user should do as follows : 
• left-click on the Stream icon to activate the 'Stream placement' operation. 
• left-click on the 'Pfd window' to define the initial point of the stream path. 
• left-click as many times as required to define the other vertices of the stream path. 
• right-click to define the end-point of the stream path. 
 
To cancel stream creation, the user can click on any point outside the 'Pfd window' 
During these actions a 'draft' version of the stream path appears on the window. 
 
When the stream drawing action is complete, the stream path is drawn on the Pfd Window, 
as shown in the next Fig. 3.5 
 

Fig. 3.5 - A stream Path in the Pfd Window 
 

 
 
In this figure, stream S1 is placed on the Pfd window as an unconnected object. 
 
Unlike the case of unit operations, when a stream is created in the Pfd Window, the relevant 
stream object is not automatically generated in the 'Simulation Data' window. 

3.8 Connecting Streams to Unit Operations 
As may be seen on the previous figure, the unit operation symbol shows handles (in the 
form of square colored boxes) that represents the connection points of feed and product 
streams. 
Feed stream handles are drawn using a yellow color, whereas product stream handles are 
shown as red boxes. 
When the mouse cursor is placed or passes over a connection box its shape is changed from 
'arrow' to 'cross'. 
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• To draw a feed stream the user should start at a free point of the Pfd and place the end-
point of the stream path on a 'feed handle'  

 
• To draw a product stream the user must begin a stream path on a 'product handle' 

and place the end-point at a free pfd point. 
 
• To draw a stream connecting two Unit Operations the user must start the stream at a 

'product-handle' and place the last point of the stream path on a 'feed-handle' of 
another Unit. 

 
Fig. 3.6  -  Connected Streams and Unit Operation in the Pfd Window 

 

 

3.9 Deleting a Stream 
To delete a stream on the Pfd the user must first 'highlight' the selected stream by clicking 
on it. The stream color will change from the ‘normal’ status to the ‘selected’ one. (default 
colors are respectively blue and red). 
Then user can then: 
a) press the 'Canc' button.  
b) start the Delete command from the Edit menu 
 
The following dialog-box will appear to ask the user which action he wants to perform. 
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The user may cancel the operation or: 
• delete the stream only in the Pfd document. 
• delete the stream in the Pfd document and its data, if any, in the 'Simulation Data' 

document. 

3.10 Operations on streams 
After a stream has been selected (highlighted), the user, may right-click on it to bring-up a 
context-type menu, as shown on the next figure. 
 

Fig. 3.7 – A pfd snap-shot with the stream menu displayed 
 

 
 
From this menu the user may select one of the following operations : 
 
View data ask the program to display, in the 'Simulation Data' window, 

stream data supplied by the user, if any. 
Detach detach stream initial and end points, if connected to unit 

operations. 
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Detach start point detach stream start point, if connected to a unit operation as a 
product stream. 

 
Detach end  point detach stream end point, if connected to a unit operation as a feed 

stream. 
 
Rename to rename the selected stream. The following dialog-box is then 

prompted when this function is selected. 
 

 

3.11 Changing stream connections and path 
The user can change the path of streams and their connection to the unit operation symbols.  
Moving the mouse pointer over a stream path the user may see its shape change according 
to the position of the mouse. 
The cursor, when positioned over stream end, appears as an  S   symbol. 
 
If placed over stream path segments, the cursor will appear as a double pointed arrow: 
↕ vertical when placed over horizontal segments  
↔ horizontal when placed over vertical segments. 
 
Moving stream end 
By clicking on a free stream end, the user can drag its position to a new place or connect it 
to a unit operation. 
Stream ends, connected to unit operations, may not be moved and must be previously 
detached using the relevant commands. 
 
Moving path segments 
By clicking on a path segment the user can drag its position to a new location. The stream 
path is redrawn taking into account this new position. Vertical segments may be moved 
either left or right with respect to the original position, whereas horizontal segments may 
be moved up or down. 
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3.12 Actions on Unit Operations 
The user can right-click on a symbol of a Unit Operation in order bring-up a context-type 
menu. 
 

Fig. 3.8 – A pfd snap-shot with the unit menu displayed 
 

 
 
From this menu the user may select one of the following operations. 
 
View data to display, in the 'Simulation Data' window, the parameters and 

other values related to this unit operation. 
 
Change Object to display the relevant dialog-box for changing the parameters 

that define the structure of the symbol or its form. E.g., the user 
may change the number of feeds/products of an heat-exchanger 
or the number of trays of a column. 

 
Detach to detach the unit from all streams (feeds and products) connected 

to it. 
 
Detach feeds detach all streams connected as feeds to this unit. 
 
Detach products detach all streams connected as products to this unit. 
 
Rename to rename the unit operation. 
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3.13 Pfd settings 
The user can specify a number of features when drawing the Process Flow Diagram, the 
following options are available: 
 
Pfd Size at any time the user can change the size of the pfd by using this 

function. The following dialog is presented to the user requesting 
the specification of the new pfd size.  

 
Fig. 3.10 – Pfd size specification dialog 

 

 
 
Enlarging the pfd size is always allowed. 
A reduction of the pfd size is rejected when some units lay outside the new desired size. 
 
 
Font height the user can modify the default value of the height of the font 

used to draw stream and unit names. Font height is given in 0.1 
millimeters units, using the following dialog box. 

 

 
 
Background color the default background color of the Pfd window is white. The 

user may select a different color. Using this option the 'Standard 
Color Dialog' is prompted so the user may choose one of the 
Windows base color or define a user color. 

 
White background selecting this command the user resets the background color to 

white. 
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Stream Settings 
The user can specify a number of options related to stream drawing by selection the 
“Stream …” command. The following dialog is prompted. 
 

Fig. 3.10 – Stream settings dialog 
 

 
 

Line colors the user can modify the standard colors used for drawing streams 
in the standard or highlighted status. Care should be applied to 
avoid inconsistencies with the back-ground color. 

 
Line width the user can modify the width of the lines that represent a stream 

for both the screen and the printer. Stream lines are specified in 
'pixels' for the Pfd window or in deci-millimeters for printing. 

 

 
 

Label position The user can set the position of the stream label with respect to 
the stream line. 
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The ‘Middle’ option is the default. In this case the stream label is drawn on the path line. 
By selecting the other options the stream label is drawn above or below the stream line. 
 
When the stream label is placed on a vertical segment of the stream line, the ‘Up’ option 
will draw the label on the left whereas the ‘Down’ option will draw the label on the right. 
When the ‘Label border’ is checked the stream label is enclosed in a rectangular polygon. 
 
Unit Operation Options 
 
The user can specify the border line width and the filling color for Unit Operation symbols. 
 
Unit color/line width  the user can modify the color used to fill the unit operation 

symbols and the width of the border lines. To change the default 
selections user interacts with the following dialog-box. 
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3.14 Zoom specification 
The user can set the size of the Pfd image on the screen by defining the zoom level.. 
This helps the user either to focus on one or more objects or to view many objects and the 
connecting streams. 
 
Set zoom  this command displays a Dialog Box with which the user can 

specify the zoom value. The initial zoom value is set at 100. See 
the next figure. 

 
Fig. 3.11  -  Pfd zoom definition dialog 

 

 
 

   Zoom in  using this command the user can reduce the zoom by 5%. The 
user can also click the related icon  on the tool-bar 

 
  Zoom out with this command the user can enlarge the size of the image by 

5%. 
 

  Fit to window this command adapts the global Pfd image to the current window 
size. 

 
  Fit to width with this command the users adapts the global Pfd image to the 

current window width. 
 

  Fit to height with this command the users adapts the global Pfd image to the 
current window height. 

 
  Fit to rect with this command the users zooms a selected rectangle of the 

Pfd to the available size of the current window. 

3.15 Pfd scrolling 
The user can scroll the Pfd window by using either the mouse or the keyboard. 
With the mouse the user can click on the scrolling bars (horizontal and vertical) that appear 
at the bottom and right side of the windows. 
 
With the keyboard the user can use the following keys 
 
↑ up, to scroll the pfd upwards 
↓ down, to scroll the pfd downwards 
→ right, to scroll the pfd right. 
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← left, to scroll the pfd left. 
 
In addition, one can use the commands: 
 
Page up to scroll one page up 
Page down to scroll one page down. 
 
Home  to scroll the pfd to the upper-left corner. 
End  to scroll the pfd to the bottom-right corner. 
 

Fig. 3.12  -  Pfd with a selected area 
 

 
 

3.16 Symbol manipulation 
The user can apply reflections and rotations to the symbol of a Unit Operation in order to 
draw a Pfd schema in an easy way. 
These operations help the user in changing the direction of the feed and product streams to 
obtain a simpler and clearer pfd drawing. Usually, the base version of the symbol presents 
feed and product streams with a left-to-right direction, so the connection of recycle streams 
would be difficult if stream directions could not be reversed. 
 
The following commands are available under the 'Symbol' menu item. 
 

  Reflect across Y axis  the symbol is reversed across a vertical line. The 
direction of feed and product streams attached 
horizontally is reversed. 

 
  Reflect across X axis  the symbol is reversed across a horizontal line. The 

direction of feed and product streams attached vertically 
is reversed. 
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  Rotate  +90° the symbol is rotated 90 degrees counter-clockwise. 
 

  Rotate  -90° the symbol is rotated 90 degrees clockwise. 
 
These actions cannot be applied to any symbol of the process unit operations. Actions that 
are not permitted are shown grayed (disabled) in the drop-down menu. 
 
Remark 
Independently of the sequence used to apply these actions to the unit operation symbol, the 
final symbol shape is generated by applying reflections before rotations. 
 

Fig. 3.13 - A Pfd with the Pump symbol reflected 
 

 
 

3.17 Moving Unit Operations  
The user can move the position of the symbol of a unit operation after it has been placed 
on the Pfd. This action may be performed either using the mouse or the keyboard. 
 
Using the mouse 
 
• left-click on the symbol of the Unit Operation to be moved, when clicking a border is 

drawn around the selected symbol. 
• holding the left-button down move the symbol, whose frame border will follow the 

mouse cursor. 
• Release the left-button of the mouse at the point where the Unit Operation is to be 

placed. 
 
Each time the symbol is moved, the program re-calculates the path of all streams connected 
with the Unit Operation moved. 
Feed and product streams not connected to other units are re-drawn keeping their current 
path. 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 29 

Feed and product streams connected to other units are rerouted automatically by program 
and their path is updated accordingly. 
 
Using the keyboard 
 
• left-click on the symbol of the Unit Operation to be moved, when clicking a border is 

drawn around the selected symbol. 
• by pressing once or more times the up, down, left or right keys of the keyboard move 

the symbol of the unit do the desired place. 
• left-click with the mouse on a empty point of the pfd to release the selection of the unit 

operation. 
 
Using the keyboard the symbol location is moved one cell for each keystroke received. 
 
Feed and product streams not connected to other units are drawn keeping their current path. 
The path of feed and product streams connected to other units is stretched keeping its 
current form as far as possible. When this is not possible the path is recalculated by 
program. 

3.18 Changing the size of Unit Operations symbols 
The user can change the size of the symbols of Unit Operations after it has been placed on 
the Pfd. 
This can be done in two different ways. 
 
Using the mouse and resizing handles 
To perform this action the user must click on the unit operation symbol. With this action a 
border with four handles at its corner appears. The user must click on one of the handles 
and, holding the left button down, extend or reduce the frame size. 
After the left mouse button is released, the unit operation symbol is redrawn according to 
the new size. In general the X and Y dimensions may be changed independently but they 
will be always multiple of the basic dimension. 
 
At the completion of the operation the path of streams connected to the unit operation is 
automatically redefined. 
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Fig. 3.14 - Unit operation with resizing handles 
 

 
 
 
Modifying scale factors 
When a unit operation symbol is selected the user can invoke the ‘Scale symbol …’ 
function under the Symbol menu. 
The following dialog box appears and the user can modify the scaling factor for the X and 
Y dimensions. 
 

Fig. 3.15 - Scale symbol dialog 
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3.19 Moving groups of units 
It is possible to move on the process flow diagram a group of unit operations. 
To perform this operation the user must first select a region of the pfd that includes two or 
more unit operations. 
By clicking within the selected region the selection frame appears and the region may be 
dragged to the new desired position. 
 

Fig. 3.16 – Pfd with two selected units 
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3.20 Deleting a group of units 
It is possible to delete from the process flow diagram a group of unit operations. 
To perform this operation the user must first select a region of the pfd that includes two or 
more unit operations. 
By clicking the CANC (cancel) button of the keyword or by selecting the Delete command 
from the edit, the user may delete all the unit operations selected. 
The user is requested to confirm the operation. 
In addition of the unit operation all the streams which interconnect the deleted unit 
operations are also deleted. 
 

Fig. 3.17 – Deleting a group of units 
 

 
 

3.21 Changing scale factors of a group of units 
When a group of units is selected the user can change in a single operation the scale factors 
of all the selected units. 
The user is prompt with the dialog box described in the paragraph 3.18 Changing the size 
of Unit Operations symbols 
The user can define the scale factors for the length and height of all the selected symbols. 
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3.22 Shifting Unit Operations and Streams 
In defining a plant simulation the user can add unit operations and streams up to fill all 
available space on the pfd sheet. When this limit is reached the user can change the pfd 
format widening the available space for placing unit operations and connections. 
In the case a user needs to insert elements at the left or at the top of the pfd, he may shifts 
all the unit operation using the :  
“Shift Uop & Streams …” command. 
 
This command prompts the following dialog box, where the user can specify the shift he 
requires. 
 

Fig. 3.18 – Pfd shift all objects dialog 
 

 
 

3.23 Renaming Unit Operations 
A command is available for renaming unit operation under the 'Edit' menu. 
 

Fig. 3.19 – Unit Operations rename dialog 
 

 
The user can click on a selected unit id causing its name to appear in the edit field. The user 
can then change the name and perform the rename action by clicking the 'Rename' button. 
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3.24 Renaming Streams 
A similar function is available for renaming the streams. 
The following dialog appears by invoking the 'Rename streams' command under the Edit 
menu. 

 
Fig. 3.20 – Streams rename dialog 

 

 
 
The user can click on a selected stream id causing its name to appear in the edit field. The 
user can then modify the name and perform the rename action by clicking the 'Rename' 
button. 
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3.25 Finding an object 
This function is provided to easily locate a unit operation or a process stream on pfd 
schemas containing a large number of elements. 
 

Fig. 3.21 – Find anobject dialog 
 

 
 
By selecting a unit operation and clicking the OK button, the unit is selected on the pfd and 
the drawing is scrolled so that the unit appears approximately at the center of the pfd 
window. 
 
When a stream is selected in the dialog, the pfd is scrolled in order to present the stream 
approximately at the center of the pfd. If the stream is a product the unit operation that 
generate this stream is selected. If the stream is a feed, the inlet unit operation is selected. 
 

3.26 View commands/options 
The ‘View’ menu contains some commands that may be used to change or update the view 
of the Pfd document. 
 
Available commands are : 
 
• Freeze Process Flow Diagram 
• Set Pfd size 
• Refresh drawing 
• View Uop connections 
• Stream start/end points 
• View External references 
• Mesh 
• Pfd toolbar 
 
Freeze Process Flow Diagram   

this command freezes the process flow diagram so that changes 
to its graphical structure are not allowed. A ‘check mark’ appears 
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on the left of the command line if already selected. Select the 
command once more to unset this option. 

 
Set Pfd Size using this option the user may extend the Pfd size or reduce the 

size of the current pfd.. 
 
Refresh Drawing selecting this command the Pfd is cleared and completely 

redrawn. This command is useful when, changing the focus 
between windows, the Pfd drawing is not completely drawn or is 
not visible. 

 
Mesh selecting this command a mesh is drawn over the pfd. This option 

may be useful to for aligning unit operation symbols and stream 
paths. 

 
Uop connections this command activates or de-activates the drawing of the boxes 

used as handles to define the locations where streams may be 
attached to Unit Operations. 

 
Stream start/end points  

this command activates or de-activates the drawing of the boxes 
used ad handles of initial and final points of each stream path. 

 
View external references  

this command activates or de-activates the drawing of dash lines 
representing external references between  unit/control operations 
and other unit operations/streams. External references exist when 
simulation parameters of one object (e.g. a SPEC statement of a 
CONTROL unit) refers to a parameter of another object (e.g. the 
pressure of a stream).  

 
Tool bar this command shows or hides the toolbars of the main window 

and the Pfd palette. It may be used to force the reshow of the Pfd 
palette in case it becomes not visible. 

 
Pfd Toolbar the user may move the position of the ‘Pfd toolbar’ using this 

command. The submenus (right, left, top or bottom) provide the 
choice to place the toolbar at one of the four sides of the Pfd 
window. 

 
NOTE 
The ‘Freeze’ command is useful to stop unwanted changes that can be made by clicking 
with the mouse over streams or unit operations. 
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4. Simulation Data 

This chapter provides general information about basic functions used to create a process 
simulation by: 
• providing the required input parameters and data 
• running the simulation 
• analyzing possible input errors. 
 
XPSIM organizes input data in ‘statements’ which are grouped in Input Categories’. 
Some statements are automatically created by the windows interface as result of some user 
actions (e.g., creation of a unit operation on the pfd); other must be explicitly created by 
the user. 
 
Though simulation data may be entered in any order, the user is advised to follow some 
basic criteria. 
 
The simulation data window is divided in two parts: 
 
• the left part shows the list of all the input statements defined for executing the 

simulation.  Statements defined by the user are shown in a ‘tree view’, similar to that 
presented in the MS-Windows ‘file manager’. The term ‘data tree’ will be used to 
identify this part. 

 
• the right part shows the data of one selected input statement and allows the user to 

insert, modify or delete the parameters related to this statement. This part will be called 
‘statement window’ in the following documentation. 

 
 
Statements defined by the user are shown in a ‘Tree view’, similar to that presented in the 
MS-Windows ‘file manager’. 
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Figure  4.1   Simulation data window 
 

 
 
 
Input statements are hierarchically organized in: 
• categories 
• main statements 
• parameter statements 
 
The input categories provided by XPSIM are: 
 
1) General Data 
2) Petroleum Data 
3) Pure Component Data 
4) Thermodynamic Data 
5) System Data 
6) Experimental Data 
7) PVT Analysis 
8) Default Data 
9) Flowsheet Data 
10) Recycle Data 
11) Network Data 
12) Vle Analysis 
13) Output Data 
14) Input Data End 
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When a new simulation problem is opened, the following categories, required by any 
simulation, are automatically created: 
 
• General Data 
• System Data 
• Flowsheet Data 
• Input Data End 
 
The ‘Input Data End’ category is empty; it does not include any sub-statement and defines 
the end of the input statements. 
 
By clicking on the ‘+’ or ‘-‘ icons, the user can expand or collapse each statement or 
category showing or hiding all the related sub-statements. 
 
Each statement is shown as a line built-up by: 
• an icon  
• a descriptive text 
 
See for example the RUN and FLASH statements shown in the previous Fig. 4.1. 
 
By clicking on the ‘statement text’, the statement data/parameters are displayed in the 
right part of the ‘Simulation Data’ window, i.e. in the ‘Statement Window’. 
 
Two commands: 
• Expand input tree 
• Collapse input tree 
are available on the View menu for working on the data tree. 
These same commands are represented by two icons on the application toolbar: 
 
  Expand may be used to expand the statement tree to show all the main 
statements associated to each category 
 
  Collapse may be used to collapse the statement tree to the base status where 
only the ‘categories’ are shown. 
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4.1 Inserting new categories 
To insert a new input category, the user must right click with the mouse at a free point at 
the bottom of the ‘tree view’. 
A context menu appears showing the available input categories. Input categories already 
inserted by the user will not appear in the selection menu. 
 

Figure 4.2 Simulation data window with new categories pop-up menu 
 

 
 
The ‘Category’ context menu is shown in detail on the next Figure. 
Only input categories not already included in the tree view will appear. 
 

 
 
Any input category can be selected, with the only exception of ‘Recycle Data’ and 
‘Network Data’ which are mutually exclusive. 
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4.2 Inserting statements 
To insert a new input statement as a parameter of another statement, the user must right 
click with the mouse on the ‘parent’ statement. 
A context menu appears showing the available input statements. Input categories already 
inserted by the user are not presented in the selection menu. 
 
For example, by right-clicking on a FLASH statement, the context menu shows the 
available parameter statements that can be added to this unit operations. See the next figure. 
 

Figure 4.3 Sub statement selection pop-up menu 
 

 
 
 

 
 
Parameter statements already defined, that can appear only once, are not shown on the 
menu. 
 
By right clicking on the same FLASH item but after toggling the ‘Ctrl’ key a different 
menu is brought up. 
 
The ‘CTRL’ key switches the menu from the ‘upper level’ to the ‘lower level’ and vice-
versa. 
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Figure 4.4 Upper statement selection pop-up menu 
 

 
 
 

 
 
Unit operation are not presented by the menu because they can be added only through the 
pfd window 
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The third menu, that can be displayed by ‘right-clicking’ with the ‘shift’ key pressed, is 
shown on the next figure. 
 

 
 
A final menu line, selected from: 
• Disable statement 
• Enable statement 
is added at the bottom of the previous menu. 
 
With this menu it is possible to cut or copy a single statement or to paste a previously 
copied statement at a desired position in an input tree. So, a user can copy the SPEC 
parameter statement of a COLUMN unit (e.g., C-1) and paste the statement under another 
COLUMN unit (e.g., C-3). 
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4.3 Statement Data windows 
Statement data are displayed in the ‘Statement Data windows’; according to the statement 
type. 
Three possible format types are used: 
• standard format 
• table format 
• unit operation format 
 
The standard format is the most frequently used. Input data for most input statements are 
entered using this format. It presents the available entries using the format shown on the 
next figure. 
 

Fig.  4.5 A standard statement window 
 

 
Each format is described in detail in the following chapters. 
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4.4 Standard Format 
The window presents all the possible entries ordered in lines with related data in columns; 
the columns have titles shown in the first line. 
 
The following columns are displayed: 
 
No contains the sequence number of each entry. 
 
Keyword contains the entry keyword that will identify the input item in the 

XPSIM input file. 
 
UoM/Spec contains either the Unit of Measure of the following value or a 

‘type’ specification (e.g. the molar, weight or volume basis of a 
flow rate.) 

 
Value contains the value of the item. 
 
Description contains a brief description of the input field. 
 
 
The ‘UoM/Spec’ column is not shown when none of the entries has this attribute. See for 
example the ‘RUN statement’ shown in Fig. 7.1. 
 
The user can enter parameters data as usually done in the Windows environment. To move 
from one field to another the user can either click with the mouse on the desired field or 
use the ‘Tab’ button on the keyboard. 
 
Using the ‘Tab’ command the user can move sequentially from one field to the next, when 
a field is not visible it is automatically scrolled into the visible area. 
 
To scroll the view with the mouse, the user must click on the arrows of the scroll-bars. 
 
Three types of data fields are available for entering data. 
 
Edit fields this fields represent the values of a statement keywords where a 

user’s value is expected (e.g. temperatures, pressures, flowrates, 
etc.) 

 
Selection lists this fields map calculation options where one value is to be 

selected within a predefined set of multiple values (e.g. the flash 
model can be selected from the following options: ISO, ADIA, 
DEW, BUB, ISOVF 

 
Check boxes. This field is used to specify a statement option represented by a 

self-defining keyword: i.e. a keyword that, when entered by the 
user, indicates that a specified option is to be used. Possible 
examples are the NORM (normalize) option in the STREAM 
statement or the CON (condenser) option of the PARA statement 
for distillation columns. 
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Edit operations 
 
Edit fields the user can enter text or number (integers or real) depending on 

the field type. Values entered are checked with respect to their 
validity and allowed length. For example, the insertion of an 
alphabetic symbol where a number is expected is immediately 
detected and signaled. 

 
Check boxes the user can check or uncheck this field by clicking with the 

mouse or using the ‘space’ key of the keyboard. 
 
Selection list the user can select one of the entries contained in the list. A value, 

previously selected, can be cleared using the ‘Canc’ button of the 
keyboard. 

 
 
Mandatory fields 
The keyword related to mandatory fields is shown in RED. The user should enter the 
required value. If the keyword is not defined, the description is shown in red. 
 
Mutually exclusive fields 
When two or more fields are mutually exclusive (i.e. only data in one field is allowed), the 
data already present in one field automatically forbids input of data in the related exclusive 
fields. To allow data insertion in one of the other fields, the user must clear the data inserted 
in the previous field. 
 
Selection list 
Some input fields allow only values to be selected from a predefined list. In this case the 
field is presented as a ‘Windows combo-box’. The user can select the desired value by 
opening the list and click on the relevant line. 
For new generated statements the value selected may appear empty or filled with a default 
value when defined. 
 

 
 
Each selection is provided with a brief description, which is shown as a ‘tool-tip’ when the 
mouse is on the field, as shown on the next figure. 
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When the number of possible choices is large to allow an easy selection from a ‘combo-
box’, the user may bring-up a ‘selection dialog’. 
This can be done by double-clicking on the relevant line either on the left or on the right of 
the ‘combo-box’. 
The following selection dialog appears. 
 

Fig. 4.6  - Selection list dialog 
 

 
 
The user can select a value and press the OK button. The value selected by the user is 
inserted in the field. 
 
 
Statement Verification 
 
Before a statement is closed (for displaying of another statement) it is verified. If one or 
more errors are found, messages are issued in a dialog box (see the figure below). 
 

Fig. 4.7 - An error message for the CALC statement 
 

 
 
The user can select one of the following actions: 
 
Correct to correct the detected error remaining on this statement. 
Next  to display the next error message, if any, related to the current statement. 
Ignore  to ignore the error message and let XPSIM to display the next statement. 
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4.5 Table Format 
This format is used only by relatively few input statements. 
Some input statements contain a number of repeatable fields, so they are displayed in a 
table-like format, consisting of a fixed number of columns and a variable number of lines. 
 
An example is shown on the next Figure. 
 

Fig. 4.8 - An example of a statement shown as table. 

 
To move from one field to another, the user can click with the mouse on the desired field 
or use the ‘Tab’ button on the keyboard. 
 
Using the ‘Tab’ command the user can move sequentially from one field to the next; when 
a field is not visible, it is automatically scrolled into the visible area. 
 
To scroll the view with the mouse, the user must click on the arrows of the scroll-bars. 
 
The first line of the table contains the description of the statement field associated to each 
column. 
The first column presents the number of lines available for input or already filled by the 
user. 
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By clicking with the right button of the mouse, the ‘line command’ menu is presented with 
the following available commands: 
 

 
 
These commands perform the following operations. 
 
Add row a new empty line is added after the last line 
 
Insert row a new empty line is inserted before the current selected line 
 
Delete row the current selected line is deleted. 
 
Repeat row the current selected line is repeated. 
 
Copy row the current selected line is copied. Its content is available for a 

subsequent ‘paste’ operation. 
 
Paste row the current selected line is replaced with the data of the 

previously copied line. 
 
The statement must contain at least one data line. 
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Units of measure on the top line 
 
When a statement, displayed using the 'table format', contains units of measure that are 
defined for the first entry only, it would be useful to have all units of measure fields 
collected and shown at the top of the table. 
This feature may be activated using the command 'UoM on second line’ from the Data 
menu. 
 

Fig.  4.9 - Units of measure shown on the top line 
 

 
 
In this case, the Units of Measure defined are applied to the first repeatable line of the 
statement and implicitly to all the subsequent lines. 
 
If the unit of measure is redefined on one of the following lines, the standard table format 
should be used. 
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Statements with Fixed Columns 
 
Some statements may contain a not-modifiable column, in addition to the column number. 
This column is usually present for statements that contains the list of the chemical 
components previously defined in the CHEMCOMP statement. 
 

Fig. 4.10 - Fixed column in COMP statement 
 

 
 
Copy and Paste Column Values 
The user can copy column values in the window clipboard or either paste column values 
generated by other applications e.g. MS Excel 
 
By right-clicking on a column title the following context menu is displayed. 
 

 
 
The user can select proper command to execute the desired function. 
When the column is empty the Copy command is not shown. 
Similarly, the Paste command is not available if the windows clipboard is empty. 
 
These functions are especially useful for exchanging data (e.g., stream compositions) 
between XPSIM and other engineering applications. 
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4.5.1 Unit Operation format 

This format is used to display and modify the header statement of the unit operations. The 
header statement presents the following data: 
 
• name 
• description 
• list of the feed streams 
• list of the product streams 
 

Fig. 4.11 - An example of ‘Unit operation format’ statement. 
 

 
 
Using this form the user can view feed and product streams of the various unit operations. 
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4.6 Help function 
In the ‘Help’ menu a function is provided to obtain a full explanation and description of 
statements and related keywords with examples and guidelines. 
When a statement is displayed on the right part of the ‘Simulation Data’ frame, the user 
can invoke the ‘Help on statement’ function. 
By selecting this command the help window is opened on the information pertinent to the 
statement. 
 

Fig. 4.12 - Help window for Thermodynamic Methods. 
 

 
 
The help window may be kept open and it will be displayed on the top of the screen each 
time the command is invoked. 
 
History of the opened Help documents is stored so the user can navigate backwards and 
forwards. 
 
This command can also be invoked by pressing the    icon on the application toolbar. 
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4.7 Component selection 
Some statements have input lines that require the specification of one or more chemical 
components selected from the list defined by the CHEMCOMP statement. 
To make this task easier a special user interface is provided. 
To fill these fields, see for example SPEC statements for COLUMN or CONTROL, it is 
possible to recall a dialog through which the user can specify one or more chemical 
components as required. 
 
The dialog is brought-up using the 'Edit component selection' menu that appears by right-
clicking with the mouse on the statement line. 
 

Fig. 4.13 - Component selection dialog 
 

 
 
Using the 'Add' and 'Remove' buttons the user can define the list of the 'selected 
components' that apply to the current entry. 
When two components are selected, the user can activate the 'components interval' 
checkbox to specify that the two components defines a component interval, i.e. the 
specification applies to all the components within the two specified components. 
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4.8 Selection of elements from lists 
Some input data define a list of elements and one or more of elements can be selected in 
other input statements. 
For example, a MATERIAL statement defines a material identifier which can be 
subsequently used to define wall layers. XPSIM builds automatically these lists and allow 
the user to select elements without having to remember their identifiers. 
When an entry can be selected from a list, by right-clicking on its field the context menu 
will appear. 
To make this task easier a special user interface is provided. 
 
The dialog is brought-up using the 'Edit component selection' menu that appears by right-
clicking with the mouse on the statement line. 
 

Fig. 4.13 - Element selection dialog 
 
 
Using the 'Add' and 'Remove' buttons the user can build the set of the 'selected elements’ 
that will be inserted in the current entry. 
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4.9 Inserting Stream or Unit Operation names 
Some statement entries require the name of a stream or unit operation. For example, the 
SPEC statements of a controller may be applied either to a selected stream or unit operation. 
When the 'Simulation Data' view works in 'linked mode' with the Pfd view it is possible to 
ask the insertion of the name of the stream or unit operation that is currently 'high-lighted ' 
on the 'Pfd view. 
 
The dialog is brought-up using the 'Selected Stream Id' or 'Selected Uop Id' menu 
commands that appear by right-clicking with the mouse on the statement line. 
 

Fig. 4.14 - Inserting stream or unit names 
 

 
 
In this example the stream ‘ZAR-IN-B’ is selected on the pfd. In the PSPEC statement 
window of the FLASH operation the ‘Selected Stream ID’ command can be executed, and 
the result is to place the stream name in the REFSTR= field value. 
 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 57 

4.10 Moving statements 
Statements may be repositioned in the ‘tree view’ using ‘drag and drop’ operations. 
By clicking on a selected item (for example a STREAM) the user can drag its icon before 
the FLASH statement. After releasing the mouse left button, the statement is positioned 
before the destination unit. 
 
XPSIM verifies that the defined destination position is allowed. For example, a STREAM 
statement may not be dragged on the ‘System Data’ category. 
 

Fig. 4.15  -  Moving statements 
 

 
 

4.11 Copy and paste statements 
Selected statements may be copied from one item and pasted over another item. 
For example, a SPEC statement of a COLUMN (e.g., C1) can be copied and then pasted 
within the parameter statements of another column (e.g., C2). 
XPSIM takes care that a statement is pasted on ‘correct positions’ of the tree data. So, a 
column SPEC statement may not be pasted on a FLASH which allows SPEC statements 
having a different syntax. 
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4.12 Selecting objects 
 
The ‘Edit’ menu provides some commands for selecting and interacting with objects. 
 
• Find stream/unit in pfd 
• Find stream/unit … 
• Find in statements … 
 
 
Find stream/unit in pfd 
By selecting on the tree-view a line representing either a stream or a unit operation this 
command becomes available. By its execution the selected stream/unit operation is 
highlighted on the pfd window.  
 
 
Find stream/unit 
This command allows the user to select a stream or unit operation from the tree view. 
 
It brings up the following dialog. 
 

 
 
The user can select an item and press the OK button. The object selected by the user (e.g 
E-4 in the above figure) is located in the pfd and its parameter statement displayed. 
The user can order the list of unit operations either by name or by type by clicking on the 
‘Id’ or ‘Type’ column titles. 
 
With respect to the analogous command available on the pfd window, the list of the 
available stream is limited to those for which input data have been defined by the user; i.e., 
feed streams or recycle streams. 
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Find in statements 
This command allows the user to select the identifier of a stream, unit operation, control 
operation, etc. and to locate it in every statement when it is referenced. 
 
This command brings up the following dialog 
 

 
 
The user can enter the name of desired object and press the “Find next” button. 
The input statement tree is searched and when the name is found in a statement, the input 
element is scrolled, selected and the related statement is displayed. 

4.13 Navigating statements 
Some simple commands are provided for seeing statement data in sequence an for 
expanding or collapsing the input tree. 
 

 expand input tree. Using this command the input tree is expanded one level 
at a time.  

 
 collapse input tree. Using this command the input tree is collapsed one level 

at a time. 
 
The input tree may be collapsed until only the category heading statements are visible. 
 
 

 Next statement. Using this command the user may display the data of the 
following statement. 

 
 Previous statement Using this command the user displays the data of the 

previous statement. 
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4.14 Statements with input errors 
As previously described, when a statement is closed, it is verified. If errors are found, 
messages are issued. The user can ignore the warning message and leave the statement with 
errors. The program allows the user to highlight at any point the input statements with 
errors using the : 
Highlight statements with errors command provided in the ‘Data’ menu. 
 
By selecting the related menu line, the command is toggled, i.e. it is activated or 
deactivated. When active, a check mark appears on the left of the menu line. 
 
Statements with errors are shown with a red icon allowing an easy identification by the user 
even with very large simulations. 
 

Fig. 4.16  - Data statements with errors are highlighted 
 

 
 

4.15 Disabling statements 
It is possible to disable one or more input statements appearing in the tree view by using 
the relevant command in the Edit menu. 
To disable a statement the user must select one statement on the data tree and select the  
‘Disable statement’ command in the Edit menu. 
When a statement is disabled, all the related sub-statements are also disabled. 
 
By clicking on a disabled statement, an ‘Enable statement’ command becomes available 
under the Edit menu. 
When a previously disabled statement is enabled, all the related sub-statements are also 
enabled. 
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This feature is designed to help the user in defining possible alternatives in the simulation 
and to keep only one active at a time. 
For example, in simulating a distillation column that allows a maximum of 2 parameter 
specifications, the user may define 3 or more SPEC statements while keeping only two 
active and disabling the others. 
Similarly, if a process flow-sheet includes parallel branches, the user can disable all the 
statements related to those unit operations which he wishes not to simulate. 

4.16 Notes & Remarks Window 
In the ‘Simulation Trace & Status” window, a ‘Notes & Remarks’ window is also created. 
In this window, the user can enter all the notes and remarks he wishes about the current 
simulation problem. 
With this function, the process engineer can describe basic data, design options and any 
other important information which could be useful in future to easily understand the 
simulation pfd and input data. 
The user can at any time add or update the text already present. 
When the simulation problem is saved, the content of the ‘Notes & Remarks’ window is 
saved together with simulation data and pfd drawing in the .xpi file. 
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5. Simulation Creation 

This section provides some general information and guidelines about the basic functions 
that can be used for creating a process simulation, providing the appropriate parameters 
and data, running the simulation and analyzing the results. 
 
When a new problem is created, XPSIM generates: 
• an 'empty' pfd  
• a 'simulation data window'  
 
The simulation data window presents the following default categories and statements: 
 
General Data 

RUN statement 
DESC statement 
DIMENSION statement 

System Data 
CHEMCOMP statement 
THERMSET statement 
METHODS statement 

Flowsheet Data 
 
Input Data End 
 
Within the 'Flowsheet Data' category no default statements are created. 
The user will define unit operations and streams using the Pfd interface and will add 
statements to these objects. 
 
Before starting the creation of the simulation Pfd the user should supply the basic 
information defined in the statements listed above. 

5.1 RUN statement 
Using this statement, the user supplies few data designed to identify the calculation. 
 
The entries provided are: 
 

ID=  calculation identification 
 
CUST= customer id 
or 
USER= user id 
 
PROJ=  project identification 
or 
PROB=  problem identification 

5.2 DESC statement 
In this statement the user can supply one or more lines of description of the problem to be 
simulated. 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 63 

5.3 DIMENSION statement 
In this statement, the user defines the units of measure of the main thermodynamic and 
physical properties (flow rates, temperatures, pressures, heat, etc.). 
One default DIMENSION statement is automatically generated; user can add two other 
statements for the definition of different output units and of an additional set of output 
units. 

5.4 System Data category 
 
In this category, the user must define 
• the list of the chemical components that will be used during the simulation 
• at least one set of thermodynamic methods for the calculation of the physical and 

transport properties. 

5.5 Chemical Components list 
Using the CHEMCOMP statement the user must supply the list of the chemical 
components that will be used during the simulation. 
 
For the definition of this list, the user can insert the component keywords in the relevant 
statement window (see next figure) or use a special dialog. 
 

Fig. 5.1  -  Component list definition window 
 

 
 
The window is initially created with 10 lines. This number may be increased using the 
standard commands available for the table format. 
 
However, for helping the user in selecting the chemical components within the component 
library, a special dialog is also available and may be invoked using the 'Select components 
…' command contained in the Data menu. 
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5.6 Chemical Components from Library 
The user is advised to define the chemical components that will be used in the simulation 
as early as possible. 
It is usual to enter components following an order which is 'classical' in the HPI 
(Hydrocarbon Processing Industry): light gases and components are entered first followed 
by the hydrocarbons in ascending order of molecular weight. 
Water is usually defined as the first or the last component. 
 

Fig. 5.2  Component selection dialog 
 

 
 

Using this dialog, the user can display the components belonging to a given class (such as 
saturated hydrocarbons, unsaturated hydrocarbons, etc.), order them either alphabetically 
or by the chemical formula (Hill order), and add the desired component (with the Add 
button) to the selected component list. 
Navigating the selected component list, the user can delete one or more specified 
components (Remove button) or change the component keyword that will be used 
throughout the simulation to uniquely identify the component. 
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By clicking the 'Change keyword…' button another dialog is invoked. 
 

Fig. 5.3 - Keyword selection dialog 
 

 
 
When components can be identified by more than one keyword (up to a maximum of four) 
the user can select the keyword he wishes. 
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5.7 Thermodynamic and transport properties 
To perform a process simulation the user must specify at least one set of methods to be 
used for the calculation of thermodynamic (VLE K-values, enthalpy, entropy, etc.) and 
transport properties (viscosity and thermal conductivity). 
These methods are defined through the METHODS sub-statement of the THERMSET 
statement. 
In the THERMSET statement, the user should only give an identifying name that will be 
used to uniquely identify the set of thermodynamic methods.  
In the METHODS statement, the user will select the proper methods for the definition of 
the various properties. 
An example of selection of thermodynamic methods is given in the next figure. 
 

Fig.5.4 -  Thermodynamic methods selection window 
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5.8 Drawing a Flowsheet 
To draw the flow-sheet the user can select the unit operations from the relevant palette 
using the standard 'drag-and-drop' operation and position the selected one on the PFD 
window. 
Similarly process streams, that carry material flows between the unit operations, may be 
created by selecting them on the process palette and drawn on the PFD window. 
 
The following unit operations are provided. 
 

Unit Operation Description 
MIXER Stream mixer 
SPLITTER Stream splitter 
FLASH Vapor liquid equilibrium operations 
COMPSEP General component separator 
VALVE Control valve 
COMPRESS Compressor 
EXPANDER Expander 
PUMP Centrifugal pump 
HEATCOOL Simple heater/cooler or heat balance 
HEATEXCH Shell&tube or LNG heat exchanger 
AIRHX Air-Cooler 
COLUMN Distillation column 
REACTOR General chemical reactor 
PIPELINE Single or multiphase pipeline 
PIPE Simple pipe calculation 
NODE Connection node networks 
PSD Pressure safety device (PSV or rupture disk) 
DEPRESS Vessel depressurization 
UCALC User calculator 

 
From the Pfd window the user can move to the data window by right clicking on a unit 
operation. The following menu will appear 
 

 
 
By selecting the ‘View data’ command the related unit operation statement will 
immediately opened and displayed  
 
Similarly by right-clicking on a stream connection a similar menu will be displayed : 
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By selecting the 'View data' command the stream data, if defined, will opened and made 
available to the user. 

5.9 Some remarks about distillation columns 
When the user selects a distillation column from the unit operation palette a dialog is 
prompted for the specification of column structure. 
The user should define: 
• Number of trays 
• Condenser existence 
• Reboiler 
• Number of feed streams and the related feed tray 
• Number of product streams, their phase (vapor or liquid), and the related draw-off tray. 
 
On the basis of this information the column symbol is drawn on the pfd window with the 
relevant handles required to attach feed and product streams. 
 
These data are used only for the definition of the column symbol not for the definition of 
the simulation data: the number of trays of the column must be given also in the PARA 
statement of the COLUMN unit and this number may be different from that defined for 
the column in the flow-sheet. 
For example, the user may draw a column symbol with 10 trays but may specify 12 trays 
in the column PARA statement. 
Similarly the user may change the feed location on the FEED statement without the need 
of updating the column symbol. 
This allows the user to perform repeated calculations and to update, if he likes, the column 
symbol only at the end of the problem solution. 
 
The following features will be provided by next XPSIM release: 
• Automatic update of column pfd symbols from input data. 
• Drawing of pump-arounds and bypasses. 
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5.10 Some remarks about recycle problems 
The user may approach the simulation of recycle problems using two possible ways: 
• defining the calculation sequence 
• letting the simulation engine to find the calculation sequence 
 
Calculation sequence defined by user 
The first case is the default option, and XPSIM will assume that the calculation sequence 
is defined by the user in the input data stream. In this case unit operations will be solved in 
the sequence defined by the ‘simulation data tree’. To change this order the user can simply 
change the position of a unit in the tree view. 
 
Calculation sequence defined by program 
The second option may be defined by setting the SEQ= option to AUTO in the 
SOLUTION statement in the RECYCLE DATA category. 

5.11 Saving the current problem 
At some point of the input preparation the user should decide to save the data already 
defined. The user must select the ‘Save’ or ‘Save as…’ command from the File menu. 
When these commands are selected, the standard MS Windows file definition dialog is 
prompted to the user. 
The user must give a name to the problem; e.g. Test-case-01 as shown on the next figure 
and press the ‘save’ button. 
The current Xpsim problem will be saved with the extension “.xpi” (xpsim input). 
The extension may be given or omitted by the user; if already defined by the user the file 
extension will not be duplicated. 
 

Fig. 5.5 -  Selecting a file name for the current problem 
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6. Units of Measure – Definition and Conversion 

XPSIM provides some support for the conversion of units of measure of input values. 
 
This section provides some general information about conversion functions together with 
guidelines and hints. 
 
For each simulation problem, the set of unit of measures (UoM), is defined by the user 
through the DIMENSION statement. This statement is always required and is created by 
the Windows interface. 
 
Its format is shown on the next figure. 
 

Fig. 6.1 - Input Dimension statement 
 

 
 
As a basic point, this statement requires the user to define the units of measure (UoM) 
system. 
 
Possible systems are: 
 

Keyword Description 
SI Standard International unit of measure 
ENG English unit of measure 
MET Metric unit of measure 

 
In addition of the basic set, the user can define specific unit of measure for a number of 
physical properties such as temperature, pressure, energy, etc. 
 
The support supplied by XPSIM windows interface is essentially based on the choices 
made by the user in defining the DIMENSION statement. 
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So the user should decide the systems of units to be used at the very beginning of a 
simulation problem and enter immediately this data into the DIMENSION statement. 
 
Utility functions provided to support the conversion of units of measure are slightly 
different for the ‘standard’ and ‘table’ formats. These functions are described by the 
following paragraphs. 

6.1 Standard format 
For each input value, that has a related unit of measure, the current selection is reflected as 
a ‘tooltip’ or ‘hint’ when the cursor remains on the related input field. 
 
For example: 
 

Fig. 6.2 - Input Field with a tooltip 
 

 
 
The UoM for temperature is shown to be °C (degrees centigrade) since this has been 
defined on the DIMENSION statement and no different unit has been selected in this 
CALC statement of the FLASH unit operation. 
 
When a unit of measure is available on the UoM column and a value has been selected by 
the user, the hint is not displayed. 
 
See the next screen image. 
 

Fig. 6.3 -  Input Field with a specified UoM 
 

 
 
In this example, a unit of measure (ATM, for atmosphere) is selected for a pressure value 
of 27. 
 
To convert a property value the user can ‘right click’ on the relevant input field, to bring 
up a context menu. 
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Fig. 6.4 - Convert value menu 

 

 
 
When the context menu is selected the following dialog is provided. 
 

Fig. 6.5 - UoM conversion dialog 
 

 
 
By selecting the ‘new’ unit of measure the input value is converted. 
By pressing the OK button the converted value is accepted and replaces original input field. 
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6.2 Table format 
For input statements displayed using the ‘table format’, tooltips/hints are displayed when 
the mouse stays on a column heading, as shown on the next figure. 
 

Fig. 6.6 - UoM tooltip on a Table Format 
 

 
 
The hint/tooltip reflects the unit of measure defined on the DIMENSION statement for 
INPUT data. 
By right-clicking on the column heading, the user can start a ‘column conversion’ 
command. 
The following dialog is issued. 
 

Fig. 6.7 - UoM conversion dialog for column data 
 

 
 
The dialog displays the first and last input values found in the column. 
The user can select the new UoM, and have all the values converted. 
In this case input values cannot be changed within this dialog. 
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The user can also ask to convert cell values. This menu is issued by right-clicking on a cell 
value, as shown on the next Figure. 
 

Fig. 6.8 - Cell value convert menu 
 

 
 
In this example, a value of the pressure column of a PROFILE statement, is be converted. 
A conversion dialog, similar to that used by standard format statements, is then issued, as 
shown in the next screen image. 

 
Fig. 6.9 - Cell value convert dialog 

 

 
 

6.3 Guidelines for UoM Conversion 
When a user wants to convert input data of a problem defined in one system of measure 
(e.g. ENG system) to a different system (e.g. SI system), the following sequence of actions 
is recommended. 
 
a) DO NOT change at first the system specification in the DIMENSION statement. This 

change should be performed only as final operation. 
 
b) Start converting all input values. Conversion dialogs will present current values as 

belonging to the initial ENG system. 
 
c) Finally, change the required entries in the DIMENSION statement, as needed. 
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7. Keyword Input Files 

A user can also prepare a simulation input using a simple text editor and set-up a keyword 
input file. In this case the user should remember statement syntax and their keywords since 
there is no way to have them displayed. 
 
When an input file has been opened by the user, the menu bar is updated to present all the 
commands available for operating on an input file. 
The following menu becomes active : 
 
File 
• New, Open, Close, Save, Save As... 
• Print, Print Preview, Page Setup...,Print Setup… 
• Recent File 
• Exit 
 
Edit 
• Undo, Cut, Copy, Paste, Delete 
• Find..., Find Next…, Replace 
• Select All 
 
View 
• Toolbar, Status Bar 
• Set Tab Stops, Set Font, Set Printer Font, Mirror Display Font 
 
 
Exec 
• Run Simulation 
• Generate Multi Output Files,  Generate a single ouput file 
 
Results 
• Global out file, Input list, Trace list, Stream results, Unit operation results  
• View graph results 
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7.1 File Menu 
The file menu contains commands for opening other input files, closing and/or saving the 
current input file. 
 
Print starts printing the input file on the selected device 
 
Print Preview opens the preview window for the active input file 
 
Page setup invoking this command the user may customize page header and 

footer. 

7.2 Edit menu 
This menu name contains in its drop-down some commands needed to edit the input file. 
 
Undo nullifies the last edit action on the input file. 
 
Cut deletes the selected text and copies it into the clipboard. 
 
Copy copies the selected text into the clipboard. 
 
Paste insert, if any, the text contained in the clipboard at the position 

of the caret. 
 
Delete deletes the selected text. 
 
Find calls the 'Find' dialog. The user may enter a string to be searched 

within the input file. 
 
Find next tries to locate the next occurrence of the string defined in the 

'Find' dialog. 
 
Replace invokes the 'Replace' dialog in which the user can specify a string 

that must replace another string. 
 
Select All selects all the text contained in the input file. 
 

7.3 View menu 
This menu option contains some commands to set tab stops for editing and to define 
character fonts for both editing and printing. 
 
Set Tab Stops invokes a dialog through which the user may define one or more 

tab stops. 
 
Set Font using this command the standard 'Select Font' dialog is invoked. 

The user may change the active font. The selected font is used 
immediately and the document window is updated to reflect the 
user's choice. 

 
Set Printer Font using this command the standard 'Select Font' dialog is invoked. 

The user may change the active font for printing. 
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Mirror display font This option may be selected or deselected. When selected the 

font specified for display is applied to printing also. 
 
 

Fig. 7.1 -   Main window with an open keyword input file 
 

 
 
 



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 78 

7.4 Window menu 
The Window menu allows to organize window documents in the main application window. 
 
Cascade arrange the open windows in an overlapping pattern so that the 

title bar of each window is visible 
 
Tile arrange the open windows side by side so that all windows are 

visible 
 
Arrange icons arrange into rows window-item icons 
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8. Executing a Simulation Run 

8.1 General Information 
After the simulation input has been prepared, the user should launch the simulation engine 
that will perform all the required calculations and generate unit operations and stream 
results. 
 
The interaction of the user with XPSIM is different if the user starts the simulation for a 
problem defined using keyword input files only or the windows interface (pfd+statement 
windows). 
 
These functions are provided by the Exec menu. 

8.2 EXEC menu 
The EXEC menu provides in the related drop-down menu commands and options to 
control the execution of the steady state simulation with XPSIM 
 
The user may request the program to generate a single output file or multiple output files 
containing the calculation results. 
When multiple output files are selected the calculation results are parsed in the following 
files : 
• Input image and input description 
• Calculation trace list 
• Unit Operations results 
• Stream list results 
 

. . .Run calculation this command starts the steady state simulation using one of the 
opened input files.  
When the pfd+data-tree mode is used, an input file is 
immediately created and the simulation is started. When keyword 
input files are used, a dialog containing the list of the opened 
input files is presented. The user must select the input file to be 
used in the simulation. 

 
 . . Stop calculation this command stops the simulation. This command can be used 

to halt unwanted calculations inadvertently started before all 
input data have been completed or updated. 
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8.3 Keyword Input file 
When one or more keyword input files are open the user can launch a simulation calculation 
for one of them. 
The program prompts the user a dialog for asking to select which file is to be used for the 
simulation. 
 

 
Fig. 8.1  -  Run selection dialog 

 

 
 
This selection dialog is available only when key-word input files are used. In this case the 
user can have more than one input file open at the same time. The user is asked to select 
the file he wants to simulate. 
 

8.4 Running the simulation 
Running the current simulation problem, is always possible.  
If one or more errors (usually data missing) have been already identified by the windows 
interface, the following warning message appears: 
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Fig. 8.2  –  Simulation activity window with completion status 

 

 
 
The window showing the calculation trace is presented on the left part of the screen. 
The status of the simulation is presented on the top-right part of the ‘Simulation Trace and 
Status’ window. 
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8.5 Fixing Input Errors 
 
Though the preparation of input data is made easier by the windows interface, a number of 
input errors can be detected only by the simulation engine when the simulation is started. 
 

Fig. 8.3 – Simulation with input errors 
 

 
 
By double-clicking over the ‘Simulation status’ pane the ‘Input Error Trace’ window is 
open as shown on the next figure. 
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Fig. 8.4 – Input Error Trace Window 
 

 
 
This window presents the echo of the input statements and the error messages. 
 
In this case the error message: 
 
* ERROR IN/BEFORE STMT     8900* Invalid relief pressure value * 
 
was generated. 
By double clicking on the message line, the related statement window is opened and 
presented to the user. 
 
This operation may be repeated for all the error messages generated. 
Some error messages may not be related to a specific statement.  
For example, a feed stream defined on the pfd may have been only partially defined, e.g. 
temperature, pressure or flowrate can be missing, so input data are not sufficient to start the 
simulation. 
In this case the user should locate the stream and complete its data. 
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8.6 Set system options 
The ‘Run’ menu allows to set some simulation options. This is provided through a dialog 
shown in the next two figures. 
 

Fig. 8.6 - System Options 
 

 
 
The first page allows the user to define the calculation date. Using this option the user can 
change the date shown on the page header of the simulation output. 
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Fig. 8.7 - Run Options 
 

 
 
The second page allows to set some options related to run and the output. 
 
Data base identifier the user can define a data base identifier. This option is 

not enabled in the current version. 
 
Interactive this check box activates an interactive simulation run. 

The user will be able to check after each loop the changes 
in the recycle stream properties and eventually terminate 
the calculation. 

 
Interactive this option may be used to suppress a warning message 

shown on the calculation output when the simulation 
convergence is not achieved. 

 
Max lines  this option allows the user to change the default no of 

lines per page. The default value is 60, a lower value is 
not permitted. Similarly, values higher that 90 are not 
accepted. 
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9. Viewing and Analysing Results 

After a simulation has been performed the user can browse or view the results in a number 
of ways: 
1) browsing basic stream results through the Pfd window 
2) browsing stream and/or unit operation results through the Pfd window 
3) opening and previewing the output file generated by the simulation 
4) viewing stream results in a ‘Heat&Material Balance’ type window 
 
These functions and options are described in the next paragraphs. 

9.1 Basic Stream Data 
Stream data can be easily browsed on the Pfd window in a straightforward way. 
By placing the mouse on a stream connection and leaving it for about 1 second, basic stream 
data such as  
• temperature 
• pressure 
• molar and weight flow-rates 
• vapor fraction 
are displayed in a tool-tip window. 
 
An example is shown on the next Figure. 

 
Fig. 9.1 - Pfd window with stream results 
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9.2 Browsing Streams and Unit Operations 
The user may locate on the Pfd the object (stream or unit operation) whose results he wishes 
to browse.  
Then he may either double-click or right click on the object.  
 
Double-clicking 
In this case the relevant results are immediately displayed in a separated window. 
 
Right-clicking 
By right-clicking on a stream or unit operation a context menu is displayed. 
 
For unit operation: 
 

 
 
For streams: 
 

 
 
Select the 'View results' command to have the calculated values displayed. 
 
A single window is used to display both stream or unit operation results. The user may 
move and size the window as he wishes. Position and size of the window are remembered 
and will be used when the window is reopened. 
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Fig. 9.2 -  Pfd window with stream results 
 

 
 
 
 

Fig.9.3- Pfd window with unit operation results 
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9.3 Heat and Material Balance view 
The complete set of values of calculated streams can be viewed in a single window by 
issuing the ‘View Heat&Material balance’ command.  
When this command is used stream data are displayed as shown on the next screen image. 
 
 

Fig.9.4- Heat & Material balance window 
 

 
 
The user can browse main stream properties, such as: 
• Temperature  
• Pressure 
• Flowrate 
• Composition 
in a single window. 
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9.4 Opening results files 
The RESULTS menu includes commands for viewing and printing result files generated 
by the simulation. 
 
The available commands are the following. 
 
Global Output this command opens the output file produced by the simulation 

and displays it in a new window. 
 
Input select this command to view the file that contains the input 

listing. 
 
Trace select this command to view the trace list file 
 
Activity Index  select this command to open and view the ‘Activity Index’. 

Through this window the user will be able to interact with the 
other output window. 

 
View graphs this command is available when the simulation has generated one 

or more graphs. When selected this command presents the user 
the list of graphs generated by the calculation. After a graph has 
been selected, a new graph document is created and displayed in 
its window. The commands available for a 'Graph document' are 
described in the next chapter. 

 
View property tables this command is available when the simulation has generated 

property tables. Generation of Property Tables can be requested 
by using the PTABLE input statement within the “VLE 
Analysis” input category. Details about the functions available 
for browsing and saving generated results are given in a 
following chapter. 

9.5 Global Output Window 
When the user has selected a file a new window is created and the related output file is 
shown. See next Fig. 5. 
The main result file is shown on the right part of the window frame. The activity index is 
presented on the left part of the screen. This last window presents results index with the 
page no.  
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Fig. 9.5 – Output and Index window 

 

 
 
By double-clicking on a line that contains a page number, the ‘Global Output’ window 
will receive a command to display the ‘selected page’. 
 
The user can set the character font for the view window and for the preview and print 
command. 
 
This is performed by selecting the 'Set Font' and 'Set Printer Font' command. 
The standard 'Font selection dialog' is prompted to the user. 
 
 

Fig. 9.6 - Font Selection Dialog 
 

 
 
To view the output files as formatted text files, with data correctly aligned in columns, the 
user should not select a proportional font but a fixed font such as 'Courier New'. 
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9.6 Output Windows 
When an output file document is shown in its window the following menu commands 
become available. 
 
File 
• Close, Save As... 
• Print, Print Preview, Print Setup... 
• Exit 
 
View 
• Toolbar, Status Bar 
• Set Font.…, Set Printer Font... 
 
Results 
• Global out file, Input list, Trace list, Stream results, Unit operation results 
• View Heat&Material balance. 
• View graph results ... 
• View Property Tables 
 
Window 

• Cascade, Tile, Arrange Icons 
 
Some of these commands have been already described in the previous chapters, so only the 
most important are reviewed. 

9.7 Save output file 
Using the 'Save as' command the user may save each output file generated by the 
calculation in a private folder. 
When this command is selected the standard 'File save dialog' is presented. 
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9.8 Print and Print Preview 
The output file may be previewed and printed using the Print preview command. 
An example is shown on next Fig. 6  
 
 

Fig. 9.7 - Output File Print Preview 
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Fig. 9.9  -  Global output scrolled to a selected page 
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10. Graph documents 

During a simulation some unit operations and other functions such as: 
 
• Phase envelopes 
• Pipelines 
• Distillation columns 
• Heat-exchangers 
• Depressurizer 
• PVT analysis 
• VLE analysis 
• Binary VLE analysis 
• Instrument and control trends in dynamic simulation 
 
generate graphical information which is of great help in the analysis and assessment of the 
results. 

10.1 General information 
Generation and availability of graphical information is reflected in the “Results” menu, as 
shown by the next screen image. 
 

 
 
The user may then select the “View graph results” command (or click the    icon in the 
application tool-bar) to access the list of the available graphs and select the desired one. 
By selecting this command, a new window is opened as shown by the next figure. It is 
divided in two parts: 
• list of the available graphs 
• graph preview 
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Fig. 10.1 – Graph selection and preview 
 

 
 
The left tree view shows unit operations and functions, which have generated one or more 
graphs. 
By selecting one line, the graph is displayed on the right part of the window.  
 
To save, print, edit and customize the graph the user can double-click on the selected 
line: the relevant graph is then opened and displayed in a new window. 
 
The menu bar is updated to reflect all the available commands to operate on the graph. 
In this window, the menu command: ‘save graph collection’ is available and the user can 
save the entire graph collection. 
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Fig. 10.2 - Graph document window 

 

 
 
When a graph document is opened the user can view it, change the size of the window, 
previewing it and printing it. 
The menu items available when a graph window is active makes available the following 
commands: 
 
The following commands are available. 
 
File 
• Save As ..., 
• Save As Metafile..., 
• Save As image..., 
• Print, Print Preview, Print Setup..., 
• Close 
 
Options 
• Scale range mode 
• Mesh 
• No color pens 
• Draw curve symbols 
• Diagonal 
• Customize 
• Reflect axis 
• Dynamic Elapsed Time 
 
Tools 
• Merge another graph into this one 
• Export curve data to Excel 
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Window 
• Cascade, Tile, Arrange Icons 

10.2 Available Operations 
This chapter describes the functions available for managing the graph object. 
 
File menu 
 
Save as … using this command, the user can save graph data on a file for 

subsequent use. When this command is invoked the 'Save as ' 
standard MS-Windows dialog is invoked allowing the user to 
select the folder and the filename. The file is save with the ‘.gph’ 
extension. 

 
Save as metafile… using this command, the user can save the graph image into a file 

for subsequent use. The image is saved in a 'windows enhanced 
metafile format' and can be subsequently imported in Word and 
Excel documents. When this command is invoked the standard 
'Save as ' dialog is displayed allowing the user to select the folder 
and the filename. 

 
Save as image… using this command the user can save the graph image into a file 

for subsequent use. The image can be saved in various formats 
such as bmp, jpeg, gif. When this command is invoked the 
standard 'Save as ' dialog is displayed allowing the user to select 
the folder and the filename. 

 
Print setup… using this command, the user can select the printer and the 

printing layout. 
 
Print … using this command the user can print the graph to a selected 

printer. 
 
Print preview using this command the user can preview the graph image before 

printing. 
 
Options  menu 
 
This menu item provides a number of commands for modifying and customizing the graph 
drawing. 
 
Customize … this command invokes a dialog that makes available a large 

number of options. It is described in detail in the next chapter. 
 
Scale range mode the user can change the mode used to define and display graph 

scales. Three predefined modes are available. Additional modes 
to change the graph aspect are available using the ‘Customize’ 
command 

 
Mesh selecting this option a mesh is drawn over the graph. Square, 

horizontal or vertical meshes can be selected. Deselecting this 
option the mesh is eliminated. 
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No color pens selecting this option all graphs are drawn using black pens. 

Deselecting this option color pens are used. 
 
Draw curve symbols this command selects or deselects the 'curve symbols option'. 

When the option is on the symbols are drawn on each curve of 
the graph. 

 
No lines exclude interpolating lines from the graph. In this case only 

symbols are shown. 
 
No single points exclude the drawing of single points from the current graph.  
 
Diagonal this option, when activated, draws a diagonal connecting the 

bottom-left with the top-right vertices of the graph. This option 
is useful when vapor-liquid equilibrium compositions (Y-X 
graphs) are presented. 

 
Reflect axis this command allows to reflect the direction of X or Y axes. E.g. 

if pressure values are displayed on the X axis in increasing order, 
using this command pressure values will be presented in 
decreasing order. 

 
X ↔ Y exchange this command allows to exchange X and Y axes. This command 

is enabled only when the graph has one X and one Y axes. 
 
Y1 ↔ Y2 exchange this command allows to switch the Y axes when the graph has 

two Y axes. 
 
Dynamic elapsed time this command is available only for graphs generated by XDSIM 

(Dynamic Option) when X axis represents elapsed time. In this 
case, default unit of measure is second. The user can change the 
time unit by selecting: 

 Seconds, Minutes, Hours and Days.  

10.3 Customization Options 
Under the Options menu, the Customize command invokes a dialog that can be used to 
change a number of graph features. 
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Title and axes description 
 
The user can change the graph title and axis descriptions. 
 

Fig. 10.3 - Title and Description 
 

 
 
Scale digits and divisions 
 
By means of this dialog, the user can modify: 
• the number of divisions/ticks for each axis 
• the number of digits of tick labels for each axis 
• the number of the decimals of tick labels 
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Fig. 10.4 - Scales custimization 

 

 
 
By clicking on one row in the Axis column, related values are copied in the editable fields.  
After desired fields have been updated, the user should press the Update button to save the 
modifications applied. 
 
Axis Limits 
Next image presents the dialog for modifying axis limits and scale factors. 
 

Fig. 10.5 - Axes Range customization  
 

 
 
For each axis, the user can set: 
• the lower and upper limits 
• the scale factor 
in order to set a desired axis range. 
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By clicking on one row in the Axis column, related values are copied in the editable fields. 
After desired fields are updated, the user should press the Update button to save the 
modifications applied. 
 
Lower and upper limits are normally set to values that encompass the lower and upper 
values for each axis. 
By setting lower and/or upper limits within the lower and upper values, only a subset of 
graph will be displayed 
 
Curve aspect 
Using the next dialog the user can modify the curve aspect for each curve included in the 
graph. 
The user can modify: 
• Line style 
• Line width 
• Line color 
• Points marker and its size 
• Curve legend 
 

Fig. 10.6 - Curve aspect customization 
 

 
 
The set of curves shown in a graph are listed in the ‘Curve classes’ window. By clicking 
on one row of this list, the related values are copied in the editable fields. After desired 
fields are updated, the user should press the Update button to save the modifications 
applied. 
 
Fonts 
For each type of descriptive line:  
• Title 
• Axis description 
• Values 
• Curve legends 
the user can change the font, its size and effects. 
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Fig. 10.7 - Font customization 

 

 
 
The user can select one font, change its properties and press the Update button to save the 
changes. 

10.4 Tools for graphs management 
In the Tool menu, the user can found two advanced functions for graph management. 
 
• Merge another graph into this one 
• Export curve data to Excel 
  
Graph merging 
The user can merge the curves of two graphs for preparing comparison charts. 
This can be done by starting the command ‘Merge another graph into this one’ available 
in the Tools menu. 
 
This command is available when 2 graphs are currently open, allowing to merge one 
graph into another. 
 
For example, the user can proceed as follows: 
a) Run a pipeline calculation, display and save the calculated pressure/temperature profile 

as. Save this graph as “TP-graph01.gph” and close it. 
b) Run another simulation of the same pipeline with different inlet condition. 
c) Open the new pressure/temperature profile graph (assume this is graph A). 
d) Re-open the saved file “TP-graph01.gph” (let us call this graph B) 
e) Activate graph A and start the ‘Merge another graph into this one’ command. 
 

As a result, graph B is included into graph A. 
 
This operation is allowed only when the two graphs have the same kind of X/Y axes with 
congruent units of measure. 
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Export curve data 
All curve data contained in a graph can be exported to MS-Excel, by starting the command: 
‘Export curve data to Excel’.  
Excel application is started, a new work-book is opened and all curve data are loaded in a 
single work-sheet. 
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11. Property Tables for OLGA and LedaFlow 

With XPSIM a user can generate property tables to be used with the “OLGA Multiphase 
Flow Simulator or LedaFlow”. 
Generated property tables can be saved on a file and subsequently used in dynamic 
pipelines simulations with OLGA or LedaFlow  
 
When, starting from the Results menu, the ‘View Property Table’ command is issued data 
are opened in a new window which may look as follows: 
 

Fig. 11.1 – Property Table window 
 

 
 
This window is divided in 3 parts: 
• the left column shows the image of property table file. 
• the right-top part shows a selection form (calculation window). 
• the right bottom part shows a line graph (result window) 
 
Property tables can be generated for more than one fluid using various options, as explained 
in the XPSIM Reference Manual. 
 
The user can select a fluid and a property, as result the file is scrolled up or down to the 
relevant property and through the calculation window either point values or 
temperature/pressure traverse can be obtained. 
 
How to save a property table 
Using the “File – Save as” command the user is asked whether the file is to be converted 
to the OLGA/LedaFlow format. 
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Calculating property values 
The user can select a fluid and a property from the available selection list. 
The file is scrolled to the relevant part where values of the selected property are contained. 
In addition the user can ask to calculate: 
• a selected point by giving one temperature and one pressure values. 
• pressure traverse by giving one temperature value 
• temperature traverse when one pressure value is selected 
 
as shown on the next figure. 
 

Fig. 11.2 – Property temperature/pressure traverse  
 

 
  



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 107 

11.1 3D Property Surfaces 
When the property tables file has been opened, the user can view the property surface which 
depends on temperature and pressure mesh defined. 
 
An example of property surface generated by XPSIM is shown on the next figure. 
 

Fig. 11.3 – A Fluid Property Surface 
 

 
 
A property may not be defined on certain intervals of temperature and pressure where either 
the vapor or liquid phase does not exist. 
In this case, the surface where the property does not exist is presented transparent and with 
no colorization. 
 

Fig. 11.4 – Fluid Property Surface with extrapolated values 
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Customize colors and intervals 
It is possible to modify the colors associated to the minimum, middle and maximum values 
and the number of subdivisions used for mapping intermediate values. 
This option can be set using the next dialog: 
 

Fig. 11.5 – Interval and colors customization  
 

 
 

The appearance of property surface can be modified by scrolling the X,Y and Z axis. 
Besides the user can also modify the screen distance which operates like a zooming 
function. 
 

Fig. 11.6 – View options definition 
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12. Importing Keyword Files 

The user can import key-word file in order to generate automatically the “Simulation data” 
interface and a related “Process Flow Diagram”. 
This function is available when a keyword input file is open as shown by the next figure. 
 

Fig. 12.1 – Starting import activity 
 

 
 
In the ‘Import’ menu the user can select the ‘Convert into Pfd / Tree data’ function. 
  



XPSIM Windows Interface  User Manual 
 
 

 
 
Version 3.02 – Jul, 2024 Page 110 

 
Fig. 12.2 - Import keyword file - activity trace 

 

 
 
The keyword input file is processed to check the validity of the input statements. 
When this first analysis is successfully completed, the input file is imported and the 
“Statement data tree” is generated. 
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13. How to prepare and run a simple simulation 

In this chapter, the user will be guided step by step through the operations required to set-
up and run a simple flash calculation. 
 
Step 1 – Start XPSIM and select input mode 
Launch XPSIM and select the ‘New’ option from either the File menu or the relevant icon 
on the toolbar. 
 
In the dialog “Select new XPSIM file type”, click on the “simulation data linked to PFD 
data” radio button. 
 
In the dialog “Define PFD size” click the “Standard” button and then select the “A4 
Horz” standard size. 
 
At this stage the main application window is opened showing the main two windows. 
 

Fig. 13.1  - Main empty application windows 
 

 
 
Step 2 – Define basic problem data 
On the left tree view of the “Simulation Data” window click on the ‘General Data’ line in 
order to expand it and showing the icons related to RUN, DESC and DIMENSION 
statements. 
 
Click on the RUN statement icon to display the relevant statement window, and fill the ID, 
USER and PROBLEM fields with some descriptive values, for example: 
ID    CALC01 
USER   PROCESS DEPT 
PROBLEM  SIMPLE TEST 
 
Click on the DESC icon to close the RUN statement and to open the DESC statement. 
This statement will show 5 empty lines. You should fill at least one line with some 
description, e.g.: 
DESC   “Simple flash calculation” 
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Click on the DIMENSION tree icon in order to close the DESC statement and to open the 
DIMENSION statement 
 
In the DIMENSION statement select “SI” for “Unit of measure system” and BAR on the 
‘pressure uom” line. 
 
 
Step 3 – Define chemical components and thermodynamic methods 
The user can now define the chemical components to be used in the simulation. 
This can be done by expanding the “System Data” category and filling the CHEMCOMP 
statement. 
Instead of directly typing the component keywords under the “Component Id” column the 
user can choose to open the “Define components” dialog by using the related command 
under the “Data” menu. 
 

Fig. 13.2 - Library component selection dialog 
 

 
 
Select the ‘Saturated hydrocarbon’ family and then add 7 components from methane to 
pentane. 
 
The user can then open the THERMSET statement and insert an identifier for the set of 
thermodynamic methods to be selected (e.g. M1) 
 
In the METHODS statement select SRK (Soave-Redlich-Kwong) method for ‘K values’, 
and LK (Lee-Kesler) method for ‘Vapor/liquid enthalpy’. 
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Step 4 – Save the partially defined problem 
At this point it would be better to save the data already defined.  
The user can select the ”Save as” command from the “File” menu. The command issues 
the standard Windows “Save as” dialog. The user can navigates within the folder he has 
already on the PC or create a new folder.  
Then he can enter the file name: 
“Simple Flash”;  
the file will be saved with the extension .xpi. 
 
Step 5 – Create a Flash unit and its feed/product streams 
At this point the user must define one unit operation at least, to do so : 
• Click on the ‘Process Flow Diagram’ window in order to activate the “Unit operation 

palette”. 
• Click on the “Flash” icon and afterward on the point where the flash should be placed. 
• The ‘Select Flash type’ dialog is opened and, in this dialog, select the second option 

“Vapor and liquid product”. 
 
The flash symbol will be drawn on the selected point, by clicking on the symbol it is 
selected and the resizing handles will appear. The user can enlarge the symbol up the 
desired size. 
At the same time, a FLASH statement, with a related CALC sub-statement, is created in 
the ‘Flowsheet Data” tree-view. 
 
The user must now insert the feed and product streams. Let us start from the feed stream. 
 
Click on the ‘Stream’ icon and then at the feed stream initial point on the left of the ‘Flash’ 
symbol. By dragging the mouse up to the yellow handle and right-clicking on it, the stream 
drawing process is completed and the stream is connected to the Flash symbol. 
 
Similarly, starting on the red handles the user can draw the vapor and liquid product 
streams. 
 
During these operations the feed and product streams identifiers will be automatically 
inserted in the FLASH statement. 
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The result is shown on the next window. 
 

Fig. 13.3  - After FLASH definition 
 

 
 
At this point the user must define the feed stream flow-rate, temperature, pressure and 
composition. The user must ‘right click’ on the Flowsheet Data category and select the 
‘Stream’ command from the ‘menu’ that will appear. 
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Fig. 13.4  - Insert object menu for Flowsheet Data 
 

 
 
Step 6 – Define feed stream composition and status 
The command will issue the ‘Select stream’ dialog and in this the user must select the feed 
stream S1. 
 
The ‘STREAM – S1’ statement is generated (with a related COMP sub-statement) and 
automatically opened. The user can insert the temperature (50°C), pressure (20 bar) and 
flowrate (1000 kg/h).  
To insert the stream composition the user must open the COMP sub-statement which will 
be shown empty with a predefined component list equal to the list previously defined. 
 

Fig. 13.5  - Stream composition window 
 

 
 
The user can enter the molar composition as either fractions (the sum should be 1) or 
percent (the sum should be 100) for the 7 chemical components from C1 to NC5. Let us 
enter 20 for C1, C2, C3 and 10 for NC4,IC4,iC5,NC5. 
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Step 7 – Define Flash conditions 
Now the user must define flash conditions. Let us suppose that he wants to flash the feed 
at 4°C and 14 bar. 
By clicking on the CALC sub-statement, the user can open it; then he must select the ISO 
option for the ‘flash type’ entry and insert the desired temperature and pressure values. 
 

Input data are now complete. 
 
Step 8 – Run the simulation 
The user can then execute the simulation by starting the ‘Run calculation’ command from 
the ‘Run’ menu or by clicking on the ‘Run’ icon on the toolbar. 
The calculation starts. 
The ‘Simulation Trace and Status’ window is activated and the report the simulation 
calculation is reported. This window will remain on the top until it is closed by the user. 
 
Step 9 – Browse simulation results 
When the calculation is completed, the user can reactivate the “Pfd and Simulation Data” 
frame to have all the output functions available. 
The user can: 
• View the stream and unit operation results by double-clicking on the relevant symbols. 
• View the global simulation results by selecting the related command from the ‘Results’ 

menu. 
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14. Advanced options and functions 

Some advanced options and functions are available under the Tools menu. 
Available functions are: 
 
• Export object 
• Import object 
• Create stream data from results 
• Export stream data to Excel 
• Merge input file 
 
Some of these functions are available only from the ‘Pfd window’. 

14.1 Export object 
It is possible to export a stream or a unit operation from the current problem. This is usually 
done with the aim to import those data in another problem. 
To perform this function the user must select either a stream or a unit operation and invoke 
the ‘Export object’ command from the ‘Tools’ menu. 
 
The user will be prompted with the standard Windows file selection dialog for the definition 
of the name of the file onto which stream or unit operations data will be exported. 
As a standard the default extension ‘.xpobj’ is used to identify an XPSIM object file. 
 
Streams that do not have input data may not be exported. 

14.2 Import object 
It is possible to import either a stream or a unit operation into the current problem. The 
object to be imported must have been previously exported from another simulation 
problem. 
To perform this function the user must invoke the ‘Import object’ command from the 
‘Tools’ menu. 
 
The user will be prompted with the standard Windows file selection dialog for the selection 
of the file to be used for importing stream or unit operations data. 
The default file extension  used for the identification of XPSIM object files is ‘.xpobj’. 
 
Streams and unit operations imported will be placed at the right end of the process flow-
sheet. 
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14.3 Create stream data from results 
The user can generate stream input data: i.e. flow-rate, pressure, temperature and 
composition from simulation results. 
When this function is invoked the following dialog is prompted to the user. 
 

Fig. 14.1 - Stream data creation - Options 
 

 
 
The user may press ‘Cancel’ to terminate this function or ‘OK’ to continue. 
At the end, data of the selected stream are generated and included in the ‘Flowsheet Data’ 
category at the end of the relevant data tree. 
 
This function is especially designed to help the user in the simulation of recycle problems. 
 
Using this function the user can generate recycle data for streams after some iterations have 
been performed and eventually adjust the last generated values. 
Stream data are generated even if another instance of the same stream exists. 
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14.4 Export data to Excel 
The user can export stream results onto the Microsoft Excel application. 
From the Tools menu  and the ‘Export data to Excel’ item, the following two commands 
are available: 
• Options… 
• Streams … 
 
The first command allows the user to modify some export options. 
The user can: 
• Exclude some properties for either the total phase or for the liquid or vapor phases. 
• Change the description of one or more properties. 
• Change the unit of measure. 
 
Units of measure are initialized with the values defined in the current simulation. 
 

Fig. 14.2 - Stream export to Excel - Options 
 

 
 
The ‘Streams …’ command performs the data export onto MS Excel which should be 
installed on the PC running XPSIM. 

14.5 Extract keyword input 
Simulation data defined by the user can be extracted from the current problem by using the 
command ‘Extract keyword input file’ in the Tools menu. 
Using this command ‘simulation data’ are written in the keyword format. 
 
The standard Windows file save dialog is then issued allowing the user to select the folder 
and the file name he wishes to use. 
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14.6 Merge Input File 
Using this function the user can include in the current simulation all the unit operations and 
streams defined in another input file. 
Before using this function the user should make sure that all the unit operations and streams 
to be imported have identifiers differing from the objects defined in the current simulation. 
If not, the import operation will not be completed. 
 
Streams and unit operations imported will be placed at the right end of the flow-sheet. 
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15. Dynamic Simulation 

Using the basic Windows interface, the user can prepare and modify both steady state and 
dynamic simulations. 
The input for a dynamic simulation run is created as that for steady state simulation. The 
unit operation palette will reflect the selected dynamic simulation environment showing a 
lower number of unit operation. Similarly, the statement selection menu will show only the 
statements allowed by the dynamic simulation in that context. 
However when a dynamic simulation is started and no input errors are detected a new 
window, i.e. the ‘Plant View Interface’ is created and displayed to provide the user with 
the interactive commands required to control the simulation.  

15.1 Dynamic Option 
To run a dynamic simulation the user must activate the ‘Dynamic Simulation’ option by 
toggling this command of the Options main menu. 
 

 
 
When the dynamic option is activated, new input files are considered dynamic simulation 
input file and the Dynamic Option Simulation Engine will be invoked when a run is started. 
Dynamic simulation input files are saved with the extension .xdy, e.g. xyz_file.xdy. 
By opening an input file with extension .xdy the dynamic simulation environment is 
automatically activated. 
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15.2 Plant View Interface 
A Dynamic Simulation can be viewed and controlled through the ‘Plant View Interface’ 
which mimics some operator control system displays. 
 
When a dynamic simulation is started and no input errors are found, the initial simulation 
status is displayed through an instrument ‘bar view’ as shown on the next figure. 
 

Fig 15.1 – Instrument bar view 
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This view is divided in two parts: 
 
Left part  includes a number of command buttons 
Right part display instruments values, trends and alarms 
 
Command buttons and their function are described in the next paragraph. 
 
The right part of the ‘plant view’ shows instruments and controls defined in the dynamic 
simulation input according to the following criteria. 
 
• Instruments and controllers, referenced by GROUP statements (defined in the 

SOLUTION DATA input category), will be grouped as defined and will occupy the 
corresponding initial pages. 

 
• all remaining instruments and controllers are collected sequentially and groups of 6 

elements are created. 
 
Example: suppose the dynamic input defines two instruments groups as follows: 
 
* 
SOLUTION  DATA 
* 
GROUP  INST=TI-100,PI-100,FI-100  UID=GP-1 + 
    DESC='INLET CONDITIONS’  
* 
* 
GROUP  INST=C1,C2,PSV-1  UID=GP-2 + 
    DESC='CONTROLLER AND PSV' 
* 
 
The first two instrument pages groups will be GP-1 and GP-2 
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15.3 Command buttons 
The left part presents a set of command buttons that can be used to control the dynamic 
simulation. 
 

Fig. 15.2 – Command Buttons 
 

 

 
 

Buttons may be available or can be disabled depending on the status of simulation and the 
type of active display. 
Buttons are divided in 4 groups as follows (from top to bottom): 
 

Pages select instrument pages display 
Display select display mode 
Events and Alarms manage alarms display 
Controls manage controllers 
Simulation control simulation execution 

 
Pages 
These buttons can be used to move from one instrument/control page to another. 
Available commands are: 
 
< Previous  to display the previous page 
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Next >   to display the next pages  
 
Page no select the number of the page to view. This command is designed 

to jump to a given page when a large number of pages are defined 
in the simulation. 

 
Display 
The following buttons are available: 
 
Bar to view instruments/controller values as bars. 
 
Trend to view instruments and controller values as trend graphs. 
 
Pfd to view Pfd (process flow diagram) or P&I (process and 

instrument) pages if defined by the user. 
 
Unit Ops to view the internal profile of some unit operations. This option 

applies to pipelines and distillation columns. The properties 
displayed by this view are those defined using the PLOT input 
statements in the OUTPUT DATA category. Default properties are 
elevation, pressure and holdup. When two or more unit operations 
are included in the current problem, the desired unit operation can 
be selected using the Previous or Next buttons. 

 
Events and Alarms 
Buttons defined in this group can be used to display active alarms and alarm history 
summary. Alarm pages will be empty if no alarms have been added to the simulation input. 
 
Alarm to view alarm pages associated instruments/controller pages. 
 
Alarm summary to display alarm summary. Alarm summary presents the history of 

alarms as turned on or off by the dynamic simulation. 
 
Events to display the list of all events defined in the current simulation 

input. Events are listed according to the time sequence and are 
marked as: completed, active or waiting. 

 
Controllers 
Buttons included in this groups are designed to operate on PID controllers defined in the 
simulation input. These commands become active only when a controller is selected on 
the relevant bar display. 
 
Manual puts the controller in manual mode. 
 
Auto puts the controller in automatic mode. 
 
Cascade puts the controller in cascade mode. 
 
On/Off this button can be used to change the operation mode of the 

controller. 
 
Simulation 
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These buttons can be used to control the dynamic simulation of the current problem. We 
should remember that interrupt time can be defined in the simulation input, so by default 
the simulation is carried on until a user’s defined time interval has been reached. 
Using these buttons the user can override the values defined in the simulation input. 
 
Available commands are: 
 
Freeze halts the simulation and puts execution in a ‘waiting status’. 
 
Go restarts the dynamic simulation. 
 
Change … in a ‘waiting status’, by pressing this button, the user interface is 

opened to allow the change of some simulation parameters. 
 
STOP by pressing this button the current simulation is terminated. 
 
 

Fig 15.3 – Instrument trend view 
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15.4 Plant View Menu Commands 
 
The Dynamic Plant Interface provides some other commands to control the dynamic 
simulation. These commands are presented in the next figure, which shows the menu pop-
up window. 
 

Fig.15.4 – Plant View Menu pop-up 
 

 
 
These commands allow the user to: 
• Change the frequency of the display update. 
• Request plots of instruments and control objects 
• Request the plot of unit operation data 
 
Each command is described in the following paragraphs. 
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15.5 Update Refresh Frequency 
Bar and trend display are updated at a certain time frequency. The default refresh frequency 
is set at 1 seconds. I.e. the user interface polls the dynamic simulation engine to get new 
simulation results if they are available. If so, results are gathered and the current instrument 
page updated. 
The default value can be changed using the menu command: “Update Display Refresh 
Frequency …” 
 
When invoked this command presents the following dialog: 
 

 
 
The user can define a new value (greater of 1 second) for the Update Frequency. 

15.6 Plotting trend and history graphs 
In addition of the plotting requests defined by a user in the simulation input, it is possible 
to request at any time additional graphs. 
 

Fig 15.4 – Instruments Selection Dialog 
 

 
 
The left list presents all the instruments and controllers defined in the simulation. The user 
can select one or more elements and with the add button places them in the ‘Selected’ list. 
A maximum of 3 instruments can be selected. 
 When the dialog is closed by pressing the OK button the graphs of the relected instruments 
are requested to the simulation engine. 
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16. Managing P&I Pages 

With XDSIM the user can define graphic pages of the process and instrument diagram 
(P&I) and to use them during the dynamic simulation for the display of plant values in a 
way similar to DCS pages. 
 
In brief, the user can: 
• prepare one or more drawings 
• define for each drawing rectangular areas that will show instrument values 
• Link each area to an instrument defined in the simulation input. 
 

 
 
The user can: 
• Create a new collection of P&I pages 
• Open an already existing collection of P&I pages 
 
When a collection of P&I pages has been prepared it can be: 
• Linked for the new calculation 
• Released if previously linked. 

16.1 Open and view a collection 
Information about a collection of pages is maintained in a file defined by the .pic extension. 
This file keeps information about the file that contains the graphic part and the instruments 
values to be displayed. 
When a collection is opened, the first page is opened and displayed as shown on the next 
figure. 
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Fig. 16.1 – An example of Process & Instrument Diagram page 
 

 
 
The windows show the first page and allows the user to move forward and backward  to 
show each page. 
 
The menu provides the following functions. 
File 

Close 
Save collection … 

 
Pages 

Add page … 
Delete page 

 
View 

Next page 
Previous page 

16.2 Commands 
The commands listed on the previous paragraph are described in more detail. 
 
Close close the display of the current page collection. 
 
Save collection … save the current collection. A standard ‘File Save’ dialog is 

presented. The user can save the collection with its previous name 
or select a new file name. 

 
Add page … using this command a new page can be added to the current page 

collection. The graph of the new page must be an existing graphic 
file (jpeg format) with a .jpg extension. The user is prompted a 
standard ‘File Open’ dialog to select the graphic file of the new 
page. 
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Delete page  the current page is removed from the current collection. The 
related graphic file is NOT deleted. 

 
Next page  the next page, if existing, is displayed. 
 
Previous page  the previous page, if existing, is displayed. 
 
 
Notes & Remarks. 
Graphic files xxyyzz.jpg selected for inclusion in the collection are not copied. The .pic file 
will only contain references to the .jpg files. 
So while .pic files can be moved freely from one directory to another, .jpg file should be 
kept in their original directory in order to be linked through the .pic file. 
 
However, in case .jpg files are moved from the original directory they can be ‘re-linked’ 
by simply editing the .pic file with any text editor. 
Links to the various .jpg files are described by the PATH keyword in the <PAGE_LIST> 
section, as in the following example. 
 
 
<PAGE_LIST> 
<PAGE> 
<NO>1</NO> 
<ID>PG-01</ID> 
<DESC>hp separator</DESC> 
<TITLE>Schema 03</TITLE> 
<PATH>C:\YD\Pfd prova\Schema 03.jpg</PATH> 
</PAGE> 

16.3 Instruments and Control values 
By right-clicking on the page window a context menu with the following commands is 
presented. 
 

Insert run-time value 
Delete run-time value 
Modify run-time value 

 
Each command can be available or disabled depending on the point on which the user right-
click with the mouse. 
 
When the insertion of a new run-time value or the modification of an already defined value 
is requested a dialog is presented. This is discussed on the next paragraph. 
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16.4 Instrument Value Format 
Information related to an instrument are defined by the following dialog. 
 

Fig. 16.2 – Instrument value definition 
 

 
 
The user must define the Instrument (or Control) Tag that must match the name of an object 
defined in the simulation input. 
In addition, the following parameters can be customized. 
• an optional prefix string 
• an optional suffix string 
 
Default presentation of instrument values can be modified by defining: 
• number of characters 
• number of decimals 
• unit of measure insertion 
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